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COPYRIGHT AND LICENSE AGREEMENT

This software is protected by both United States copyright law and by international treaty provisions. Therefore, you must treat
this software just like a book.

By saying “just like a book”, Simplicity Systems, Inc. means that this software may be used by any number of people and may
be freely moved from any one computer location to another, as long as there is no possibility of the software being used at one
location while it is being used at another. Just as a book cannot be read by two or more people in two different places at the
same time, neither can this software be used by two or more people in two different places at the same time. To do so is a
violation of copyright law.

This software may not be installed on any multi-user or LAN system without obtaining written permission and a site license
from Simplicity Systems, Inc.

A site license may be purchased to allow this software to be used on more than one computer owned by the purchaser, including
a multi-user network. Contact Simplicity Systems, Inc. for additional information.

LIMITED WARRANTY

>

This program, instruction manual and reference materials are sold “as is,” without any warranty as to their performance,
merchantability, or fitness for any particular purpose. The entire risk as to the results and performance of this software is
assumed by the purchaser.

However, to the original purchaser only, Simplicity Systems, Inc. warrants the magnetic media on which the program is
recorded to be free from defects in materials and workmanship under normal use for a period of 90 days from the date of
purchase. If within this period of 90 days the diskette should become defective, it may be returned to Simplicity Systems, Inc.
for replacement, provided the purchaser has previously filed a warranty registration form.

Your sole and exclusive remedy in the event of a defect is expressly limited to replacement of the diskette as provided above. If
the failure of the diskette has resulted from accident or abuse, Simplicity Systems, Inc. shall have no responsibility to replace
the diskette under this limited warranty.

Any implied warranties relating to the diskette, including any implied warranties of merchantability and fitness for a particular
purpose, are limited to a period of 90 days from the date of purchase. Neither the author nor the publisher of this software shall
be liable for indirect, special, or consequential damages resulting from the use of this product. Some states do not allow the
exclusion or limitation of incidental or consequential damages, so the above limitations may not apply to you.

SUPPORT

Simplicity Systems, Inc. will provide support free of charge to registered users for a period of 90 days from the date of purchase,
provided the user has returned a signed software registration form acknowledging his or her acceptance of the terms of the
Copyright and License Agreement, Limited Warranty, and Support Agreement as previously stated herein. Furthermore, initial
support will be provided without return of the registration form for a period of 10 days from the date of receipt of the software
by the original purchaser.

Support for hardware related questions and problems, for software produced by manufacturers other than Simplicity Systems,
Inc., and all support provided after the initial 90 day period will be billed to the caller at the rate of $1.00 per minute with a
$15.00 minimum. This rate is subject to change without notice.



THE COPYRIGHT - English Translation

You are guilty of theft if you...

1.

Use a single copy of this software on more than a single machine at a time without first obtaining a
site license agreement.

. Use a site licensed copy of this software at any location other than the location for which a site li-

cense is granted.

Modify this software without first obtaining written permission from Simplicity Systems, Inc.
Attempt to unlock a demo version of this software without the permission of Simplicity Systems,
Inc.

. Copy any or all of this program manual without first obtaining written permission or a site license

from Simplicity Systems, Inc.

Install this software on any multi-user or LAN system without obtaining a site license from Sim-
plicity Systems, Inc.

Sell this software license to a third party without first destroying all archival copies of the disk
and/or manual, and erasing all portions of this software from any storage device.

Any violation of the above constitutes copyright infringement and theft, and all violators will be
prosecuted to the fullest extent of the law.
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AL Section 1
7 et The Basics

Introduction

Contour It! is a Windows based program that provides you with a
simple method for generating maps, digital terrain models, and for
computing the volume between two surfaces. The program is
designed to run inside “Sight” Survey Professional (our
Windows based COGO and CAD software - if you don’t have it,
you should!), but it will also run as a stand-alone program. (See
Section 6.)

Contour It! contains several menus and provides numerous monitor
prompts and screens to guide you. You will be capable of running
Contour It! without the aid of the manual in a very short time.

This short learning curve will be demonstrated to you if you take
the time to run the example problems in Section 3.

Your ability to use Contour It! to its fullest potential depends upon
your understanding of its principals. So with that in mind, begin
by reviewing some basic terminology relevant to Contour It!.

1.02 What is a Contour?

con’tours (kon’toors)z. 1. a line joining points of equal elevation
on a surface. 2. the representation of such a line on a map. 3. a
travel agency for felons. (Con Tours - get it? Only one page into
the manual and you’re already wondering what you got yourself
into.)

You guessed it... We know you know what a contour is, or you
wouldn’t have purchased the program. We were just searching for
something to say to get us started.

Contour It! will produce contour and surface maps containing just
contour lines, just triangles, or both contour lines and triangles.
You may also include labels, point numbers, breaklines and a
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Contour Line Rules

border. Two examples of contour maps are shown below. The
example on the left shows contours and triangles, while the
example on the right shows only contours. Label, breakline and
border display are not illustrated here.

Contour maps are only as accurate and complete as the data you
provide in your point file. To assure the integrity of the data,
Contour It! checks your data as it loads. There are a few rules you
must abide by:

1. You must have at least three points in a contour point file.

2. You cannot have any duplicate points in a contour point file.
This includes points having a different point number but
identical Northings and Eastings.

3. Incomplete points (those missing a Northing, Easting, or
Elevation) are ignored.

4. Point numbers must be numeric. Alpha-numeric point numbers
are not allowed in Contour It!

What is a Digital Terrain Model (DTM)?

A digital terrain model, or DTM, is a 3-D representation of your
contour data. A DTM will typically include some type of grid to
assist you in viewing the surface.

In Contour It!, the DTM normally consists of the contour lines
and/or triangulation grid. Border, breakline, and label display is
optional. Shown on the next page are three DTM examples. The
first example shows a DTM consisting of contours and triangles.
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The second example shows a DTM consisting of triangles only.
The third example shows a DTM consisting of contours only.

Like contours, a DTM is only as accurate as the data you provide.
This includes not only complete field data, but triangulation,
border, and breakline data as well.

What is a Border?

A border consists of line segments connecting the outermost
points in the contour point group. Every contour map must have a
border, although the border does not need to be visible on the map.
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Specifying a Border When passing points from “Sight” Survey to Contour It!, you are
given the opportunity to enter a border. To specify a border,
simply type in the point numbers of the border (perimeter) points.
You may also select the border points visually by using “Sight”
Survey’s Get String (GS) command. An example of how to do this
is shown in Computing a Volume, beginning on page 38.

Border Rules 1. If you do not enter a border, Contour It! will attempt to provide
one for you. You may edit this border with the Edit = Border
routine as discussed on page 60.

2. Border lines can never cross each other.

3. Breaklines may never cross a border line.

() What is Triangulation?

Triangulation is the basic technique used by Contour It! for
surface modeling. “Surface model” refers to Contour It’s
representation of the actual surface resulting from the data points
that are input.

When Contour It! triangulates a set of coordinates, it builds the
strongest set of triangles for that data. Since the strongest triangles
are equilateral triangles, Contour It! tries to make all triangles as
nearly equilateral as possible, using the coordinates given.

Triangulation is simply the process by which Contour It! defines
between which points linear interpolation is appropriate for

determining contour lines.

The illustration below represents several data points that have been
triangulated.

Notice that the lines connecting the points form triangles, and
hence the name triangulation. These lines are very important
because they represent a relationship between data points. Imagine
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two points on a surface, connected by a string. If the surface does
not get in the way, the string will be a straight line between the
points. The elevation of the string is that of the data points at each
end and changes linearly between the points (along the string).

The lines on the previous illustration are exactly like the imaginary
string. Each line represents a linear change in elevation between
the two points it connects.

The triangles formed are individual planes. When pieced together,
they represent the surface and form the “surface model”.

Contour It! tries to form the “strongest” set of triangles, given the
existing data. This means that long, narrow triangles are avoided
whenever geometrically possible. By maintaining triangles as
nearly equilateral (sides the same length) as possible, Contour It!
represents elevation changes over the shortest distance, thus
yielding a better surface model.

The most important advantage of triangulation is that the elevation
of each original data point is preserved in the surface model. Both
research and experience have proven this to be one of the most
accurate methods of surface modeling.

Another advantage of triangulation is that the data points
describing the surface may be randomly spaced or grid spaced,
allowing more information to be gathered where necessary, and
less information where not needed.

=r REMEMBER

The only data Contour It! has available to build an accurate
surface model is the data you provide it. Contour It! cannot
make assumptions from data it does not have!

There are some situations that occur where the triangulation
technique can fail to accurately describe the surface. Most of these
situations are a result of insufficient data or improper placement of
survey shots. Others situations are simply beyond the capabilities
of triangulation. However, very few situations exist in the real
world that are beyond the capabilities of triangulation to model.
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The two primary situations that Contour It’s triangulation can not
model are:

1. Exact vertical walls
2. Cliffs and overhangs

If walls are displaced from vertical by even 0.001 feet from the
top to the bottom, the surface can be modeled. However, the
resulting surface model may be difficult to work with.

Any other situations that occur can usually be handled in Confour
It! by using breaklines.

1.06 What are Breaklines?

A breakline is a line segment connecting any two points. Break-
lines have the ability to modify the surface model by locally ad-
justing the triangulation. By changing the triangles, the relation-
ship between data points is changed. This produces a different
surface model and thus different contours.

Breaklines are helpful for defining objects such as building slabs,
and retaining walls, grade lines, roadbeds, ditches, canals, etc.

Breaklines permit:

1. Post processing to alter portions of the triangulation thus
generating a more accurate surface model;

2. Control of the triangulation by specifying lines which triangle
sides cannot cross. Their use allows preservation of significant
terrain features even though the lack of sufficient data may favor a
different triangulation;

3. Definition of ditches, roadways, terraces, etc. with a minimum
of field data.
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The drawings below show one example of how a contour map is
affected by breaklines. In the first drawing, you see a building
(shown as a dark square) in the center of the parking lot. The
parking lot is divided into eight drainage areas, the center of each
being a storm drain. These drainage areas are defined by lines of
constant elevation radiating out from each corner of the building.
These lines will serve as our breaklines.

s e ¢

Breaklines
Storm Drain

"y

L,
Border ————— " v
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A
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Breaklines

Now we’ll contour the data. The example on the left illustrates the
incorrect contours that are generated when no breaklines are used
to construct the contour map. In the example on the right, the
breaklines have been included and we have correctly contoured the
drainage areas.

o)) O] (=]
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Ditch Example Sometimes the optimal triangulation results in the joining of three
points which actually should not be triangulated together. The best
example is across or around a ditch. Consider the following cross
section of a ditch.

A R D F

C

Note that points B and D are on the banks of the ditch and point C
is at the bottom of the ditch. Shown below is a top view of the
ditch. All lines (A-A’, B-B’, etc. are straight lines).

A B C D E
. ' ' ' .
[ ] : L] : [ ]
A B’ ok D’ B

The dashed lines above represent the banks and bottom of the
ditch. If the points shown were triangulated, the result would be:

A B C D E

A B’ c D’ E’

This is a valid triangulation, so no further changes in the surface
model would be needed. However, if the points were surveyed in
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the following manner and then triangulated, the results would look
like this: (Note that ABCDE is not a perfectly straight line.)

C

A B’ c D’ E’

As you can see, points B and D become the side of a triangle BCD,
causing Contour It! to assume the surface is linear between them.
Shown in the next two illustrations are the contour maps of the first

“good” surface model, and the second “bad” surface model, listing
the elevations at each point.

13.0 10.5 55 10.5 12.0

12.0 10.0 5.0 10.0 11.0
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13.0 1056 —— 105 12.0
L] L]

.

12.0 10.0 5.0 10.0 11.0

One way to solve the problem is to instruct Contour It! NOT to
triangulate across a user-defined line (a breakline). For example, if
you were to define a breakline between points C and C’, then
Contour It! would check to see if any side of a triangle crosses that
breakline. If a side does cross the breakline, Contour It! redefines
the triangulation so no triangle side crosses the breakline. After
adjusting for the breakline, the following triangulation and contour
map would result.

A B’ c D’ E’
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5.5
.

13.0 10.5 10.5 12.0
L] [ [ L
[ ]

12.0 10.0 5.0 10.0 11.0

When passing points from “Sight” Survey to Contour It!, you are
given the opportunity to enter breaklines. To specify a breakline,
simply type in the point numbers of the beginning and ending
points, separating the points with a comma. You may also select
breakline points visually by using “Sight” Survey’s Get String (GS)
command. An example of how to do this is shown in Section 3.03,
Computing a Volume, beginning on page 38.

Sometimes you might have a breakline that changes direction a few
times. For example, imagine a three-segment breakline snaking
from point 1 to 2 to 3 to 4.

2 4

Technically, a breakline is only one segment long. To specify a
multi-segment line, you must include each segment in the breakline
string. In this case, an entry of 1,2,3,4 would result in two
breaklines: from 1 to 2; and from 3 to 4. Each breakline must be
represented by a pair of points. To properly enter this three
segment breakline, type 1,2,2,3,3,4.
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Breakline Rules 1. Each breakline is always defined by two points.
2. A breakline cannot cross a border.
3. A breakline cannot cross another breakline.

4. A breakline cannot cross a data point.

=r REMEMBER

Breaklines can be created either before of after triangulating the
data file. It is often better to create breaklines after the initial
triangulation to avoid creating unnecessary breaklines.

1.07 What is a Tension Factor?

The tension factor controls the smoothing function in Contour It!
The range for the tension factor is zero to 10. The higher the
tension factor, the sharper the corners are drawn.

Suppose you have a string loosely draped around some push pins,
as shown in the illustration below. The string is anchored at the
left end, loose on the right end. Now, the tension factor is zero.

Ve

Now grab the loose end and slowly pull it to the right. As you pull,
you’ll notice the curve of the string begins to flatten out, and
continues to do so until the corners at the push pins are sharp.

When you cannot pull the string any more (without removing the
push pins) you have achieved a tension factor of 10.

A tension factor of zero allows more curving of the line, while a

tension factor of 10 results in no noticeable line smoothing. Any
value between zero and 10 may be used. The value does not need
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to be a whole number. In general practice, values from zero to 5
are most commonly used. See Edit Contour Setup on page 70 for
more information on Tension Factors and Segments per Curve.

1.08 What is a Bitmap?

A bitmap is a picture made up of dots. This type of picture is also
known as a raster graphic, as opposed to a vector graphic (such as
a CAD drawing) which is made up of lines.

Raster or bitmap graphics are simply pictures, nothing more,
nothing less. You can enlarge them, shrink them, and rotate them,
but they can get pretty ugly if you do. You can save them to a file
and import them into other programs. You can print them on your
printer. But, no matter what you do to them you cannot move a
line or isolate a point or do anything you can do with a vector
graphic.

With Contour It! alone, you can save your contour map or DTM in
a bitmap image. This is often helpful when you want to include a
graphic as part of a report, but virtually worthless if you want to
manipulate your map inside a COGO/CAD program. Sadly, if you
are running Contour It! as a stand-alone program, saving your map
as a bitmap is all you can do. But don’t despair. Using Contour It!
with “Sight” Survey Professional allows you the freedom of
choice! Once your map is back in “Sight” Survey Professional
(note the word “Professional” here folks, the plain “Sight” Survey
version won’t work with Contour It!) you can save it as a
TrueCAD drawing file, an AutoCAD 12 drawing file, a DXF file,
and yes...even as a lowly bitmap. What versatility! Remember
now, that’s “Sight” Survey Professional. If you don’t have it, call
us at 1-800-777-7978 or 1-218-773-8917 and buy it!

1.09 The Reference Manual

This Contour It! manual is designed to provide information in

a clear, convenient format. As you page through the manual sec-
tions you will notice that the program’s monitor prompts and the
names of the routines are shown in Bold Style Helvetica letters. All
prompts are followed by detailed instructions for each needed



14 The Basics

Section 1
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Help

Index

response. In cases where the manual indicates a specific response,
the response is printed in Bold Style Courier letters.

The Reference Manual is organized by sections and includes:

This section includes a general introduction and discussion of
basic contouring elements. It also includes sections on response
terminology and using the pull-down menus.

Contains installation and setup information for this program.

Contains two example problems: 1. Constructing a basic contour
map; and 2. Calculating a volume. Breaklines are also discussed in
the second example.

Contains information regarding Contour It’s menu structure,
including complete discussions of each menu item.

Contains information on Contour It’s tool bar buttons, including
complete discussions of each right and left-click function.

Contains information on running Contour It! as a stand-alone
program.

Contains troubleshooting information and error messages.

Contains info you need in the event that you find it necessary to
call Simplicity Systems for technical support. Our support hours
are listed in this section, as are the numbers for contacting us by
phone, fax, or E-mail. But be warned... If our support technicians
discover that you haven’t read the manual, they will use a large
wooden ruler across your knuckles.

Contains a comprehensive listing of routines and terms, and where
they can be found within this manual.
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The display illustrations shown throughout this manual may
differ slightly from your actual displays. Screen captures for the
manual were made while running Windows 95.

Response Terminology

Throughout this manual, you will see a variety of instructions for
answering all of the various types of prompts. Some prompts will
require a YES or NO answer, while others will be accompanied by
instructions to ENTER your response. Still others will contain
instructions for you to PRESS a key (either on the keyboard or
with your mouse) in response to a given prompt. In an effort to
simplify your operation of this program, the following guidelines
shall apply to all of the prompt responses for all Contour It!
routines.

When you encounter an instruction which requires you to Enter
data, the program expects you to press after the data has been
typed. When you encounter the word Press or Type, the program
is indicating that it is expecting you to respond with a single key
press, or a series of key presses. In these cases, do not press
after your response.

Since Contour It! is a Windows program, you can expect to see a
number of references to your mouse. It used to be possible to say
“click” or “right-click” your mouse button and everyone knew that
“click” meant the main mouse button, located directly under your
index finger on your right hand. Now that a mouse can come with
left hand configurations or software for configuring a right-hand
mouse as left handed, “click” takes on a slightly altered meaning,
no longer referring to the left button, but simply the main mouse
button, still located under your index finger. (Unless you are using
a right handed mouse configuration with your left hand.)
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Keyboard Responses

Button Responses

Accessing Menus

I REMEMBER

When you are asked to click your mouse, click once on the main
mouse button, located under your index finger. Right-click
means to click once on the secondary mouse button. “Double-
click* simply means two clicks in rapid succession.

In this manual you will occasionally see [KIEIYCIAIP) responses
which indicate that you should press the key or keys shown. When
you see keycaps shown in combination (but not with an key)
such as (AR)E], press the first key and hold it down while pressing
the second key.

In most cases, pull-down menu items may also be selected from the
keyboard. This type of selection will be depicted in some form of
this manner: (], @) or ARIE), [, @). To respond to this type of
entry, press the first key and hold it down while pressing the sec-
ond key, then release the keys and press the next key (or keys) in
succession. DO NOT press the 2] key.

When a combination includes an key, such as [EJEEne], press
and release the keys shown in succession.

Even though the key presses and responses within this manual may
be shown in capital letters, lower case data entry is acceptable.

You will also see graphic representations of Windows response
buttons, such as [Aceept]. Activate a response button in one of two
ways: either by clicking your mouse on the button, or (in this
example) by pressing (At)[A), Cee], where the letter following the
key corresponds to the underlined letter on the button.

Menus are accessed using the keyboard or your mouse. To access
any of the menus, either click on the menu name or press (for ex-
ample) (At)[E), where the letter following the (i) key corresponds to
the underlined letter on the menu name. In this case, the File menu
would have been opened.
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Once a menu has been opened and you are presented with a list of
routines, simply click on a routine or press the letter corresponding
to the underlined letter in the routine name.

An arrow () on the right end of a menu item indicates the
presence of a sub-menu. Selecting that item or simply using your
mouse to move the highlight bar over the item opens the sub-menu.
Select items from any sub-menu in the same manner as you would
select an item from a main menu.

In this manual, menus and sub-menus are depicted in the following
manner: Menu 2 Sub-menu 1 2 Sub-menu 2.

The manual uses the symbol = to indicate items in a menu
structure. For example, the function Edit 2 Drawing Entities

> Contours is on the Drawing Entities sub-menu of the Edit menu.
To get to this function you select the Edit menu (with your mouse
or by pressing (At][E]), then the Drawing Entities item (with your
mouse or by pressing DJ). Finally you would select the Contours
item (with your mouse or by pressing (C)).

Read Me Files

Quite often, software manufacturers will place a file on their
disk(s) which contains information regarding software version up-
dates and features not described in the manual. These files are
typically named ReadMe.Txt, ReadMe.Doc or just Read.Me. It’s a
good idea to always directory your software to determine if the
disk contains a “Read Me” file.

The ecasiest way to read a “Read Me” file is to load the file into the
Notepad or Write program in Windows 3.1, or into the Wordpad
program in Windows 95. From any of these programs, you can

scroll through “Read Me” files or print them to have a paper copy.
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7 et Setup

Minimum System Configuration

To function effectively, Contour It/ must run on a computer
incorporating a DX 386, DX 486, Pentium (or better) CPU.

Required Items:

1.

kW

6.

Windows 3.1, 3.11, WFW 3.11, or Windows 95;
8 Mb of RAM;

One 3% high-density floppy drive;

A hard drive with at least 5 Mb of free space;

A VGA (or higher resolution) display adapter;
A mouse, or compatible point device.

Optional Hardware:

7.
8.
9.

A math coprocessor, if you are using an SX style CPU;
A dot matrix or laser printer;
A plotter.

Optional Software:
10. “Sight” Survey Professional (If you don’t have it, buy it!
Call 1-800-777-7978 or 1-218-773-8917 now. Operators are
standing by! Just another shameless plug!)

2.02 Do You Need A Site License

Your purchase of Contour It! is nothing more than a license to
run the Contour It! program on a single computer. You may need
an additional site license if you plan to:

O Install Contour It! on more than one computer at

your place of business;

O Install Contour It! on a home computer;

O Install Contour It! on a field computer;
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The “Transportable “
License

Multiple Office
Installations

Network Installations

O Install Contour It! on a network computer or
server;

O Have Contour It! available at temporary field office sites
within your company.

The best rule to follow is: If there is any probability that a single
copy of Contour It! will be running on more than one computer
at a time, an additional site license is required!

Realizing that you may not always perform your job entirely in the
office, the Contour It! license is a “Transportable” license which
allows you to copy Contour It! to your home computer and use it
there for no additional fee, provided that Contour It! is used in
accordance with the copyright. In other words, you may use
Contour It! under the “Transportable” license only when you are
certain that no other licensed copies of Contour It! are running at
the same time.

If the Contour It! license was originally purchased by a Company,
and the Company has multiple owners, the license extends to one
owner only. The Company must purchase site licenses in order for
additional owners and/or their employees to have a legal copy of
Contour It! on their home computers. The purchasing Company
retains ownership of ALL licenses of the programs.

The “Transportable” license may also be used to allow Contour It!
to be loaded on a portable field computer instead of, or in addition
to, a single home computer, if the user can guarantee that only a
single copy of Contour It! is running at a time.

The Contour It! license covers only a single site, i.e. building

or address. If you have multiple locations, each location is ex-
pected to purchase their first license at full cost, with subsequent
purchases for each location in accordance with the established site
licensing fees.

If Contour It! is loaded on a network computer, either a server or a
node, a site license may be needed. If the network administrator
limits access to Contour It! to a single user at any one time, a site
license is not needed. However, if Contour It! is available to more
than one networked computer at a time, at least one additional site
license is required. The number of site licenses required is based
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on the number of computers likely to be using the program concur-
rently, not necessarily the total number of computers on the net-
work.

Site Licensing Fees A site license granting you permission to make an additional copy
of this software and manual is available at approximately 50% of
the full version price, per computer licensed. An extra manual
and disks may be purchased from Simplicity Systems at an
additional cost. Prices are subject to change without notice. Call
for verification.

2.03 Installation

Contour It! may only be installed to a hard disk containing at least
5 Mb of free space. To install Contour It!, you must begin by
loading Microsoft Windows. To simplify the installation instruc-
tions, we will assume that you are logged to drive C:\> and your
floppy disk is drive A:\>.

Step 1. Place the Contour It! disk into your floppy drive.

For Windows 3.1x users, use your mouse to select File ® Run
(or press (At)[F), B)) and type A:SETUP [Ene].

For Windows 95 users, use your mouse to select Start 2 Run
(or press (At)(S), B)) and type A:SETUP [Ene].

Step 2. Follow the installation instructions that appear on your display.
We strongly recommend that you accept the default directory
structure, (but not necessarily the disk drive), presented in the in-
stallation program. NOTE: If you have “Sight” Survey, Contour
It! must be installed to the same drive and directory containing
“Sight” Survey.

Step 3. After the installation is complete, store the original Contour It!
disk in a safe place.

Step 4. After you’ve finished the installation procedure, your computer
will automatically place a Contour It! item into your Simplicity
Systems program group.
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2.04 Product Registration

Product registration is part of the installation process. You will be
asked to provide or verify your name, company name, address and
telephone number. This information, or at least portions of it, must
be provided or the registration program will fail. The information
provided is used in two places. Your name and/or company name
will automatically appear on your job printouts, but more
importantly, the information entered is used to prepare your
product registration form for you. Once you have entered and/or
verified your data, click on [Aceent], or press [AA). You will be
asked if your data is correct. Ifit s, click [ Yes |, otherwise click

At this point, we strongly suggest that you print the registration
form, sign it, fold it, stamp it and mail it in. It’s a quick and simple
task that you are urged to complete.

Product registration is important for many reasons. It provides us
with updated information so that we can contact you with upgrade

information, etc. But perhaps most important is that we will not
provide support for unregistered software.

2.05 Un-Installing Contour It!

Contour It! may be easily un-installed from your computer by
clicking on the Un-install Contour It icon in the Simplicity program

group.

If, for some unfathomable reason, you do un-install Contour It! and
return it for a refund, remember. ..

We know where
you live!
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’ Test Drive

The Pitch

“Hey there! How ya do’in? Thanks for droppin’ by Fast, I mean
Honest Eddie’s new car and software emporium.”

“I see you’ve set your sights on that sleek “Contour It!” model
from Simplicity Systems. A superb choice, if I do say so myself.
Why, this little beauty comes in a wide range of colors, and is
loaded with so many features it’ll make your eyeballs spin!”

“And fast? Whoa, let me tell ya! This little baby can do 0 to 200
points in a few seconds or less. And it has a virtually unlimited top
end! Curves, hills, flat plains, you name it. Contour It! can handle
‘em all.”

“But hey, don’t just take my word for it, which incidentally is good
as gold. You gotta jump behind the wheel and take it for spin.
Ready? Have fun!”

3.02 Your First Test Drive

We’ll start in “Sight” Survey with a project containing coordinates
and we will create contour lines based on those coordinates. Along
the way we’ll learn how to change contour settings, as well as how
to create a bitmap that can be placed into virtually any windows
program. The whole process should only take about 5 or 10
minutes. Then, starting with Section 3.03, we’ll show you how to
use Contour It! to calculate a volume between two surfaces.

In order to use Contour It! we need to have some coordinates to
work with. The following steps will take you through loading a
project into “Sight” Survey and getting Contour It! running.
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Start It Up Begin by starting your “Sight” Survey program. If you are already
familiar with “Sight” Survey procedures, skip ahead to the Fill’er
> Up sub-heading and continue from there.
You can start “Sight” Survey in a wide variety of ways, just as you
can for any Windows program. This manual will touch only on the
most common startup method for both Windows 3.1 and Windows
95.

> If you do not have a copy of “Sight” Survey Professional, you need
to follow some different instructions. The following text on
opening “Sight” Survey is irrelevant to you, but the examples are
Buy It Today! not. We will be splicing in special instructions for you to follow,
with occasional references to topics included in Section 6: Stand-
Alone. Look for instructions marked by the No “Sight” Survey
icon as shown to the left. For startup instructions, please turn to
page 89.

Windows 3.1

Mouse Method: Double-click on the Simplicity Systems program
group. When the group window opens, double-click on the “Sight”
Survey icon ( [& ).

Keyboard Method: Press (A)E],R) to open the File ® Run dialog
window. Type C:\SightSrv\SightSrv into the filename
box and press [Ere]. (If necessary, change the drive letter and di-
rectory name to match your installation.)

Windows 95
Button Method: Click on the Windows 95 but-

ton. Point to Programs. After a moment, the program list appears.
Point to Simplicity Systems. After a moment, the Simplicity Sys-
tems program group list appears. Point to “Sight” Survey and click
your mouse once.
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Keyboard Method: Press (At)S], [®) to open the Start ® Run
dialog window. Type C:\SightSrv\SightSrv into the
filename box and press or click [__O0K_]. (If necessary, change
the drive letter and directory name to match your installation.)

To complete this test drive we need some “gas,” or data. Select the
menu item File ® Open or press AR)F], © to open the Filename
Dialog Box. If you are familiar with procedures for opening a data
file, select the file Contour1.zak. (Open Original.xyz if you are
running Contour It! as a stand-alone program.) This file was
installed with the Contour It/ module if you selected the complete
install. If you selected the compact install option, you might want
to rerun the installation program and select complete installation.
Now skip to the Check Your Route sub-heading and continue from
there.

The Filename Dialog Box is used to select the data file to be loaded.
A typical filename dialog box is shown below for reference. Key
areas of the dialog box are identified.

Current File Path

File Name box |contourl.zak | erisightsry
Asnlit zak \ Cancel
File selection menu oo T = Qe =

Folders or
Directories box

pagloper @A,
File name: \ Folders:

[ e |

9 sightsiv

Drives box

contour? zak

lezample. zak 7 collconn

nakwonds zak -l (3 program
[ utility

List Files of Tvoe box 4T [*sight” Survey Files 7] [ e =

\ Drives:

List fileg of type:

@ REMEMBER

The sample screens were captured in Windows 95. Your screens
may vary slightly, depending upon your version of Windows.




26  Test Drive

Opening a File

%

Buy It Today!

Check Your Route

- «

Anytime a File ® Open command is issued, you will be presented
with a filename dialog box. To open a file:

1. If the file you want to open is on a different drive, select the
drive you want from the Drives box.

2. In the Folders (or Directories) box, choose the directory you
want to open. (Double-click the directory, or press the [4] or
[x] arrows to select the directory, and then press )

3.  Windows displays the names of all files in that directory that
are of the type selected in the List files of type box. To display
a different type of file, select the type you want from the List
files of type box.

4. From the list of files, select the file you want to open.

5. Click [0k

At this point, we want to open the data file Contour1.zak. (Open
Original.xyz if you are running Contour It! as a stand-alone
program.) This file was installed with the Contour It! module if
you selected the typical installation. The file should appear in the
file selection menu portion of the filename dialog box. If it doesn’t
appear, you probably selected the compact installation option.

You might want to rerun the installation program at this time
selecting a typical installation.

After the project is loaded, we are ready to start creating contours.

Running Contour It! as a Stand-Alone Program
Continue at the Contour It! screen on page 29.

Select the menu item Add-Ins 2> Make Contours or press @AR)(1], M.
Selecting this option tells “Sight” Survey that we want to create
some contours. “Sight” Survey responds by setting up the Contour
It point selection window to allow you to select what points should
be used for creating the contour lines.
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MContowt  EEH|

1 10000.00000 20000.00000  119.650 | (St it
2 10002.08000 20104.46000  104.940 use for cantours:
3 10003.45000  20203.76000 123.760 |:|
4 10006.95000 20301.63000  112.620
5  10006.11000 2040557000  119.010 Select all |
6 10006.82000 20506.26000  129.350
7 10108.46000 20501.19000  130.830
2 1020261000 20501.81000  133.500
9 10299.92000 20504.53000  148.610 Accept

10 1040258000 20508.49000  117.630

11 1050952000 20503.81000  146.800 Border

12 10507.92000 20399.70000  103.680

13 10508.75000  20308.71000 133.420 Break Line
14 10501.20000 20202.90000  126.840
15  10500.44000 20104.85000  145.970
16  10506.80000 20001.48000  144.490
17 10402.80000 20004.75000  144.620
18 10303.83000 20008.60000  101.450

K| ;I;‘

LCancel

T
[
(B o]
e |

To select all of the points in the file, simply click once on the
button. To clear your selections, click the button.
To select individual points at random, click your mouse on the
desired points. Selected points will be highlighted.

For this example, click [Seestal |,

ESTABLISHING BREAKLINES AND BORDERS
UNDER NORMAL USE

Under normal use, you would probably want to define a border
and breaklines before clicking to begin the contour
calculations. In order to illustrate the automatic bordering
feature, we are not defining a border and breaklines at this time.
However, here is how you do it:

To begin, you may want to issue a Point Plot (PP) command in
Sight Survey to show your points on the monitor.

To set a border or breakline: After you have selected the

points to contour, but defore you click [Accept ], click the | Boer
button or the BekLne | button. At the top of the Drawing window
you will see a prompt for a point string.
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Let’s Go!l!

il Drawing

Use String |16. 15, 14

You may also see a message similar to:

w. Border Select |_ (O] x| I

You can define a border by selecting
points from the CADD window, or you
can type them in the text box at the top
of the CADD window. When finished

selecting click Use String
u] 4 |

["'Do not show thiz message again;

Enter the point numbers of the border or breakline(s) or click on
the desired points in the Drawing window and then click [[UseSting |.

If you are entering breaklines, remember that you must enter
beginning and ending points for each segment. For example, a
breakline from 1 to 2 to 5 to 7 must be entered as 1,2,2,5,5,7.

When you have finished entering your border and breaklines,
click on to begin the contour calculations.

Ready? Here we go. Click on the button to signal

“Sight” Survey that all the information it needs has been entered.
“Sight” Survey will check to see that the information is valid
before creating the contours. Based on the selected points,
Contour It! automatically generates a border and in a moment, the
contouring window (shown on the next page) should be visible.

Any breaks or spaces you may see in the contour lines indicate
the placement of elevation labels.
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Contour It - CONTOUR1 ISI=] E3 |
FEile Edit “iew Help

B E

Drag the drawing to change wview position. Shift to rotate.

The border automatically defined by Contour It/ may not be the
precise border you want to use. To view (and subsequently edit)
the border, select Edit ®Border by pressing (AR)E), B). The Edit
Border window will appear.

Edit Border H=] &3
Point = 0K |
1 ﬁ 1
.......... 5 Cancel
10 Insert ]
11
13 Delete !
16
Delete All !
Pt. String ]

Notice the border points 1, 6, 10, 11, 13, and 16. These points were
automatically selected by Contour It! as being the outermost points
of the data set, and as such were used to define its border.
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For this example we want to use a border consisting of points 1-20.
First we must erase the border points shown. Click or press
to delete all of the points.

Now we will insert the new border points. Click in the first open
box. Now click the button to open the Pt. String Wizard.

Pt. String Wizard

Enter a point string, such as 1-10 or 1,3,5.7.9
[1-20 |

x/l]l( | x Cancel |

Type 2-20 and the new border points will be entered. Click
to recontour the data with the new border.

Contour It - CONTOUR1 (O] =]
File Edit “iew Help
EE] & (2] [CEBRVE
Al
_I
LI B
Kl I I
Drag the drawing to change view position. Shiftto rotate.

Congratulations, we are almost done. In the Contour It! window
you can see an image of our project with contour lines created.
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Contour Interval

Minimum Contour

Maximum Contour

Smoothing
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The drawing may be kind of ugly if the contour lines are too close
together. Also, the contour lines are very straight. It might be
more visibly pleasing, though not necessarily more correct, if we
remove some of the lines and smooth out the lines that are left.

Select the menu item Edit ® Contour Setup, or click on the button
with a picture that looks like a wrench ( |[£|). This brings up the
contour setup dialog box where you can change settings for the
contour lines, including the contour line interval and smoothing.

e~ |

— LContour Range

Contour Interval:
X Cancel

Minimum Contour: 10000 s
P Hel
Mazimum Contour: (10000 s 4 4w

—|v Smoothing

Tenszion Factor:

IK

Segments/Curve:

I

The Contour Interval is the elevation difference between contour
lines. For example, a setting of 5 causes contour lines to be drawn
for every 5 foot (or units) change in elevation. Change the contour
interval to 5. Press to jump to the next entry field.

Type in a Minimum Contour Value. Contour It! will not draw any
contour below this level. For this example, just ignore this entry
and press to jump to the next entry field.

Type in a Maximum Contour Value. Contour It! will not draw any
contour above this level. For this example, just ignore this entry
and press to jump to the next entry field.

Click in the box to the left of the word Smoothing. This will
enable smoothing, which will round your contour lines. Press
to jump to the next entry field.
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Tension Factor

Segments per Curve

Re-Contour the Data

The Tension Factor determines the amount of “roundness” of the
contour lines. A higher number will cause the contours to appear
more round. Set the tension factor to 3. Press to jump to the
next entry field.

Contour It! creates smooth contours by breaking the contour line
into smaller line segments. For example, a Segments per Curve
setting of 3 will cause the contour lines between any two data
points to be broken into 3 segments. Set the segments per curve to
3. Press to jump to the next entry field.

Click the button. This will close the contour setup dialog
window and redraw the contour map.

lﬁ Contour It! [ [O] ]
File Edit “iew Help

= B 28] [FEELM

hd| L2

Drag the drawing to change view poszition. Shift to rotate.

You should now see considerably fewer contour lines on the
screen. Since we are placing contour lines every five feet instead
of every foot, there are 1/5 as many lines. Also, the lines that are
left are now slightly rounded giving a more visually appealing
drawing.
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Edit Border Elevation

Rotate Your Drawing
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Since our “Sight” Survey drawing already has point numbers on it,
we don’t want to print a second set of point numbers.

Running Contour It! as a Stand-Alone Program
Since you do not have a “Sight” Survey drawing, please skip this
step. Continue at the sub-heading Edit Border Elevation.

Select View R Points to remove the check mark next to the word
Points. If there is not a check mark in front of the word Points,
omit this step. You may also hide/show the triangulation, border,
breaklines, and/or contour lines in the same manner by
deselecting/selecting those items from the View menu.

The contour lines are now complete. At this point, we could return
to “Sight” Survey, but there are a few other features we should

explore first. If you don’t want to bother with these features right
now, continue at The Joy Ride’s Over on page 37.

Select Edit = Border Elevation or click on the Border Elevation
button ([#]). Set the elevation at 100 and click [ 0K _].

Border Elevation I

Enter the elevation at which the ~/ oK
border should be drawn:
x Cancel

=
m 3 7 Heb

You can rotate your drawing to view it from a different angle.
Follow these simple steps to get a different perspective of your
data. Try them all to see what happens, but don’t get sea-sick with
all the rockin’ and rollin’ going on!

1. Position your mouse near the South (bottom) edge of the
drawing.

2. Press and hold the left mouse button down while slowly moving
the mouse North (up).
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Zoom & Scroll

3. While keeping the mouse button pressed, move the mouse East
and West (right and left).

4. Hold the key down while moving your mouse to rotate the
drawing about an axis normal to the monitor.

5. If you would like to reset the drawing to the original viewing
position, select File = Contour or click on the Triangulation button
([E) or Contour button ( [&] ) on the toolbar.

You can zoom or horizontally and vertically scroll your drawing to
view it from a different angle. Follow these simple steps:

To Zoom your drawing, click and hold the right mouse button on
the Zoom slider on the left side of your contouring window. Now
move your mouse up and down to zoom in and out.

To Vertically Scroll your drawing, click and hold the right mouse
button on the Vertical Scroll slider on the right side of your
contouring window. Now move your mouse up and down to scroll
up and down.

To Horizontally Scroll your drawing, click and hold the right
mouse button on the Horizontal Scroll slider on the bottom of your
contouring window. Now move your mouse right and left to scroll
right and left.
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# Contour It |- (O] x| I
File Edit Yiew Help we—

e[ (] [2[2] | [2[BEN]D]
B

\ — Pull-down menus ‘.\
Tool bar
t Zoom slider Yertical Scroll slider :Il
Zoom Scrall bar Yertical Scroll bar

X

‘ Display Window

Horizontal Scroll bar
Horizontal Scroll slider
! S
(4] [ o

Status Bar

b

Edit Line Properties Maybe you would like your triangulation lines to be dashed. You
can easily do this by selecting Edit ®Drawing Entities ® Triangles
or by clicking the right mouse button on the triangles button ( | )
on the toolbar. In the box labeled Line Type, click on the down
arrow ([@]) to expose the choices. (In some instances, you may
need to use the slider bar to view additional choices. Point to the
slider bar, click and hold the left mouse button, and slide the bar up
or down.) Select Dashed and click the button.

Triangle Settings E I

Color: By B v X
- C |
Line Type: |EDNTINUDU5 j' x —
P Hep

Line Width:

Layer: | Triangles j|
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Edit Text Properties

Create a Bitmap Image

From this settings box you can also change the line color, width,
and the layer upon which your triangles will be placed once you
return to “Sight” Survey.

In a similar manner, you can change the appearance of the border,
the breaklines, and/or the contours.

Change text settings by selecting Edit > Drawing Entities ® Labels.

The font style, size, and color may be changed by clicking on the
style button. For now, we’ll leave these settings unchanged and
continue on. The text properties styles are discussed under Edit
2 Drawing Entities = Labels on page 62.

You can create a bitmap image of your drawing at any time by
selecting File ® Export as Bitmap.

Title Bar Save As BE I
Current File Path File-mame: Folders:
. contour]l_bmp \$ c:hsightsry
File Name box - | Cancel |
- et -
File selecton menu —— gl &5 sightsry
7 collconn
Folders or (L] program
Directories box [ wtility [ Read only
Drives box 7
Save file as type: \ Drives:
Save Files as Tvbe box —————# j | S j
Saving a Bitmap Anytime a File ® Export as Bitmap command is issued, you will be

presented with a filename dialog box. To save a bitmap file:

1. To place the file you want to save on a different drive, select
the drive you want from the Drives box.

2. Inthe Folders (or Directories) box, choose the directory you
want to save the file to. (Double-click the directory, or press
the [«] or [¥] arrows to select the directory, and press )
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3.  Windows displays the names of all files in that directory that
are of the type selected in the Save files as type box. To
display a different type of file, select the type you want from
the Save files as type box.

4. Enter the name of the file you want to save in the File Name
box, or click on an existing name in the list of files shown in
the file selection menu.

If you select a name of an existing file, the existing file will not be
overwritten unless you confirm your intent to overwrite the file.

5. Click[_oK 1.

At this point, we want to save the file Contourl.bmp. Enter
this name into the File Name box and click [_0K_|.

The Joy Ride’s Over Sadly, your first test drive has come to an end. It’s time to close
the Contour It! window. Select File ® Finish or click on the Finish button ( [#] ). The Contour It!
window will close and the program will terminate.

If you activated Contour It! from within “Sight” Survey, you will
now be returned to “Sight” Survey, where your contours will be re-
drawn in the CAD Output window. From “Sight” Survey you can
print, save or modify your drawing using the available “Sight”
Survey commands.

If you are running Contour It!
as a stand-alone program, it
will simply terminate.

If you activated Contour It! from within “Sight” Survey and you
saved your contours as a bitmap, you can now import that bitmap
into your drawing by selecting File ® Import 2 Bitmap.
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3.03

Buy It Today!

Computing a Volume

Predictably enough, the first part of this example looks strangely
like the road you traveled in the previous example. If you didn’t
do the first example, you must do it before you can continue.

In “Sight” Survey (or in Contour It! if running stand-alone), select
the menu item File ® Open or press (At)FE], @) to open the Filename
Dialog Box. Open the file Contour2.zak. This file was installed
with the Contour It! module if you selected the complete install. If
you selected the compact install option, you might want to rerun
the installation program and select complete installation.

Running Contour It! as a Stand-Alone Program

The filename you want to open is Proposed.xyz. When the file
opens, you will not see a drawing similar to the one on the next
page. However, you should use this illustration for reference while
completing the breakline editing.

Open K E3 I
File name: Folders:
|cunluur2_zak | c:hzightsrvy

. Cancel |

cadsplit.zak - et -

contourl._zak :

o

lesample.zak collconn

oakwoods. zak [ program

[ utility
>

List filez of tppe: Drives:

I"Sighl" Survey Files [‘_zj I = j

After the project is loaded you should see the “Sight” Survey
screen shown on the next page (only the drawing portion is shown
here).

The tract shown measures 508’ x 506°. The dark square in the
middle of the tract represents a building approximately 150’
square. The remainder of the tract is to be a parking lot which has
been split into eight drainage areas, each centered with a storm
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drain. These areas are bounded by the dashed lines. All points and
proposed finish elevations are also shown. (Depending upon your
drawing window size and your display resolution, you may not be
able to read the numbers without zooming the drawing.)

We have arbitrarily set the building elevation and border elevation
at 132.0 feet, which was the approximate average elevation of the
existing ground. We intend to run the 132.0 elevation away from
the building on the dashed lines. Each dashed line will be a
constant 132.0 elevation.

104
132.0

107
1320

124
127.0

105
1320

120
129.0

103
1320

i
| :
| :
| :
| :
| :
| :
| :
17 | 118 i 19
1270 i | 1270
1 e
| :
| :
| :
| :

101 1112 ALK 10
1320 T4320 T4320 1320

Finally, our soil has no shrink/swell factor so we will try to make
our cut and fill volumes as close to equal as we can.

Running Contour It! as a Stand-Alone Program
Please skip the next paragraph.
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Select the menu item Add-Ins 2> Make Contours or press @AR)(1], M.
Selecting this option tells “Sight” Survey that we want to create
some contours. Once again, “Sight” Survey responds by setting up
the Contour It point selection window to allow you to select what
points should be used for creating the contour lines.

Click [ eketal ], then click on the button to signal “Sight”
Survey that all the information it needs has been entered. “Sight”
Survey will check to see that the information is valid before
creating the contours. Based on the selected points, Contour It
automatically generates a border and in a moment, the contouring
window should be visible.

[# Contour It - CONTOUR2 M=l 3
File Edt Wiew Help
EE & 2] REEME
2] N
J L]

=
= hd|

Kl _ 2

Contour It! automatically selected the points 101-112 as a
border. This is the correct border for this figure, so we will not
need to edit the border as we did in the first example.

Normally, you might press A(Erte], ) to edit or enter Breaklines
at this point. However, for this example we don’t want to add any
breaklines just yet.
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Yuck! You are looking at your finish grade contours. Obviously,
this does not fit the eight drainage areas we had planned. We must
use breaklines to further define these areas. Before we set any
breaklines, let’s adjust some settings so we get a better picture of
what we are looking at.

Coming from the first example, our contour interval was set to 5
and we employed smoothing. Given that we have a much smaller
change in elevation over this site, we should decrease the contour
interval. Click the Settings button ( 2] ) to set the contour interval
and smoothing options. Set the Contour Interval to 1 and un-check
the Smoothing option. Click to re-contour with these
settings.

T |

— Contour Range ‘/
0K

x Cancel

Minimum Contour: -10000 -
|
Maximum Contour: 10000

—1 Smoothing

Tension Factor:

Contour Interval:

D

Segments/Curve:

I
4]

I~ Seament Midpoints

We will also turn off our label options, just to show all contours as
continuous lines, with no breaks for labeling. Right-click your
mouse on the Show/Hide Labels button ( [] ) and set the Options to
None. Click to re-contour with these settings.
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Label Setup I

Style: T ‘ < 0K |

Kl
j

Options: Mone

Starting Contour:

Contour Multiple:

!!IBJ

Orientation: Uphill

Frequency:

Precision:

Layer: ContLabels j

Finally, just to clean up the drawing a little more, we’ll turn off the
triangle display by clicking on the Show/Hide Triangles button

(E&).

Iﬁ Contour It - CONTOUR2 M=
Eile Edit Miew Help
E[E| (& [2]2] i
2l , B
_I a

1=
= -

Kl | o]

Since we still do not have our eight drainage areas well defined, it
looks like we need to add some breaklines.
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To add breaklines, we will use the Edit ® Breaklines routine.
Select Edit ® Breaklines from the menu or by pressing (AHJE), (K].
(Note: When the Edit Breaklines window opens, it will be blank.)

Edit Breaklines B [= B3
From Point |Tn Point I: 0K

112 113 e

113 102 Cancel

103 114 Insert

114 105

106 115 Delete

115 108

Delete All
109 116

You need to add several breaklines at this time. To begin, click
your mouse in the empty square in the From Point column. Type
112 [Ente]. The cursor moves to the To Point column. Type 113
CEte]. You have just added the first breakline, and the cursor
should be in the next row in the From Point column. In a similar
manner, type in these point numbers:

From Point From Point
113 102
103 114 [“Ente]
114 (Enter] 105 (Enter]
106 (Ente] 115 [“Ente]
115 (Enter] 108 [Enter)
109 (CEnte] 116 [“Ente]
116 (Enter) 111 (CEnte]

Now click to re-contour the data. When your map
appears, click the Show/Hide Triangles button ( | ).
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[ Contour It - CONTOUR2 =] B3
File Edit “iew Help

=] (2 [2[2] 0
=] . [«]

_I L]
L] [ B
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Doing the Math We have completed and are satisfied with the final contours so it’s

time to compute the volume between this surface and our existing
surface. Select File ® Calculate Volume.

Information E

To compute a volume pou must load a secondary file.
Calculations will then be bazed on the two files

This message is a reminder that Contour It! needs another surface
to compare to for volume calculation. This surface must have
already been contoured or it will not be a valid surface. We will
load the existing surface from the first example. This file was
Contour1.zak. Click to access the File Open routine.

Running Contour It! as a Stand-Alone Program
The filename you want to open is Original.xyz. Continue at the
next No “Sight” Survey icon on page 46.

Buy It Today!
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e @mH|
File name: Folders:
|contouﬂ _zak | c:\zightsry

_ Cancel |
cadsplit.zak - e -
onto 2 =5 sightsry

contour2. zak [ collconn

lesample.zak

oakwoods. zak [ program

(2 utility

List files of type: Dinives:
I"Sight“ Survey Files [‘.:j I = j

Select the file Contour1.zak (or Original.xyz if running stand-alone)
and click [_OK_|. At this point, one of two things will happen: 1.
The volume between the two surfaces will be calculated; or 2. You
will receive this error message:

Error

Q

Both files must be triangulated before volume calculations can be
performed.

This message indicates that the first file has never been processed

by Contour It!. It cannot be used until you have triangulated the
file. You must:

1. Return to “Sight” Survey and open the file Contour1.zak.
Make Contours on this file.

2.

3. Return to “Sight” Survey and open the file Contour2.zak.
4. Make Contours on this file.
5.
6.

From within Contour It!, select File ® Calculate Volume.

Select the file Contour1.zak and click [__0K_].

Please continue at the Volume Calculation Results screen shown on
page 46.
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Running Contour It! as a Stand-Alone Program

Select the file Original.xyz and click 0K |. At this point, one of
two things will happen: 1. The volume between the two surfaces
will be calculated; or 2. You will receive this error message:

Error

Both files must be triangulated before volume calculations can be
performed.

This message indicates that the first file has never been processed
by Contour It!. It cannot be used until you have triangulated the
file. You must:

1. Use File ® Open to open the file Original.xyz.
2. Use File ® Open to open the file Proposed.xyz.

3. Select File ® Calculate Volume.

4. Select the file Original.xyz and click [_0K_].

[f Volume Calculation Results M= E I
Volume Calculatio Results ﬂ
Calculated On: 9/11/97

Secondary File: CiWw3IGHTERVYCONTOURZ
Primary File: C:WZ3IGHTIRV\CCHNTOURL

Total Cut Volume
Total Fill Volume
Maximum Cut
Maximum Fill
Total Area Cut
Total Area Fill

49117.129 cu. yards

E56540.042 cu. yards
34,000 feet
87.250 feet

.911 acres

Z2.817 acres

4] I 2

nwon
-

The report contains the date and both filenames, the total cut and
fill volumes, the points of minimum and maximum cut (including
Northing and Easting coordinates), and total area of both cut and
fill. You may have to use the horizontal and vertical sliders to see
all the data in the window.
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If you want, you may click the cursor in the window and add notes
to the volume report.

When you click you are returned to the main Contour It!
screen. The volume window disappears but is not lost. Before we
return to “Sight” Survey, click the Show/Hide Points button ( [2]),
the Show/Hide Triangles ( [¥] )button, the Show/Hide Breaklines
button ( [\{] ), and the Show/Hide Border button ([ ). This will
allow us to bring only the contours into our “Sight” Survey
drawing.

Click on the Finish button ( #4| ) or select File ® Finish to close
Contour It! and return to “Sight” Survey where the volume data
will be added to your Text Window printout.

In the example above, we measured the following:

Total Cut Volume = 49117.129 cu. yards
Total Fill Volume =  66540.042 cu. yards
Maximum Cut = 34.000 feet
Maximum Fill = 87.250 feet
Total Area Cut = 2.911 acres
Total Area Fill = 2.817 acres

To save time in our example, we used the finish grade as the
primary file, and the original ground as the secondary file. This
means our volume data is inverted. We could have avoided this
problem by triangulating and contouring Contour2.zak (or
Proposed.xyz) before Contour1.zak (or Original.xyz).

We actually have 66,540 cu. yards of cut and 49,117 cu. yards of
fill. The ratio of cut to fill is 1.35:1. We originally stated that we
have no shrink/swell factor so we want our cut and fill to be
approximately equal.

The difference between cut and fill is 17,423 cu. yards. To balance
the volumes, we will need to move approximately one-half of this
volume (8712 cu. yards) from cut to fill. In other words, we need
to raise our final grade.

But how much do we raise it? We have a total fill area of 2.817
acres, or 122,708.5 sq. feet. 8712 cu. yards equals 235,224 cu.
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feet. Dividing this volume by the fill area gives us the change in
depth that we need. 235,224 cu.ft. /122,708.5 sq.ft. = 1.92 feet.

Running Contour It! as a Stand-Alone Program

For the remainder of this example, you must either have “Sight”
Survey or some other COGO program that has a Coordinate
Transformation routine. Follow the general procedures below,
adjusting for your program. The export your data to an xyz file.
See File Structures - Point Files on page 90 for the xyz file format.

Buy It Today!

Since we are back in “Sight” Survey, it is easy to adjust our finish
grade elevations to raise them by 1.92 feet. Select Misc 2
Coordinate Transformation = Rotation Point and Angle Known.

Coordinate Transformation

@ Would pou like to save your work firgt?
Ho |

Select an option by clicking a button. You don’t need to save your
work at this time though.

Enter and Azzign

Point Humber I:I
Morthing
Elevation I:I
Dezcrption I:I

Accept | LCancel |

Click [Ganeet],



@ CT: Rotation Point & Angle =] E3

GO - Azcept input and perform calculation.

Baze Point |1 01

New Noith [10000

New East (20000

Mew Ele |m

Fotation |':|-D':I

Scale |1 00

Poirts |1m 124

‘ Accept [PgDn)
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In the Coordinate Rotation data entry window, type 101 for a Base
Point, type 133 . 92 for a New Elev, and type 101-124 for

Points. Click on [EesaFama]

After your coordinates have been translated to the new elevation,

select Add-Ins = Make Contours or type MC to return to the Make

Contours window. The points, border, and breaklines default to

your previous settings. Click on [2szept Pabn].
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[@ Contour It - CONTOUR2 [ To0=]
File Edit “iew Help
(] [#] [2[2]
= : N
.
[-] ] =
[]
= : =
A | -

Select File ® Calculate Volume.

Information

To compute a volume pou must load a secondary file.
Calculations will then be bazed on the two files

|x LCancel |

Click to access the File Open routine.

Open B I
File name: Folders:
|conlour1 _zak | c:\zightsry

_ Cancel |
cadsplit.zak - e -
onto 3 25 sightsry
contour2.zak 1 collconn
lesample.zak
oakwoods. zak (1 program
(20 wtility
Lizt files of type: Drives:
I"Sight" Survey Files ['.:ﬂ I = j
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Select the file Contour1.zak (or Original.xyz) and click [__0K_].

[f Volume Calculation Results (O] x] I

Volume Calculation Results ﬂ

Caleulated On: 9411797
Secondary File: Ci:ZWSIGHTSEVY CONTOURZ
Primary File: C:4WSIGHTSREVYCCNTOUR1

Total Cut Volume = 58691.209 cu. wyards
Total Fill Volume = 558369.451 cu. yards
Maximum Cut = 35.920 feet

Maximam Fill = §5.330 feet

Total Area Cut = 3.264 acres

Total Areas Fill = Z.404 acres

=]

q | o]

In our recalculated example above, we now measure a cut volume
of 58369 cu. yards and a fill volume of 58691 cu. yards, a minor
difference of 322 cu. yards. Our cut/fill ratio is 1:1.01, which is
acceptable. (Remember, our file order was reversed so our cut and
fill values are reversed from the screen above.)

That’s it! We’re done.
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AL Section 4
gt Menus

The File Menu

Shown below are the items in the File menu. To select any item on
the menu, click your mouse on the desired selection. You may also
use your keyboard to select a menu item by pressing plus the
underlined letters. For example, select File 2 Triangulate by

pressing (AR)(F], (.

Open

Triangulate
Contour
Calculate Volume
Export as Bitmap

Finish
Cancel
File ® Open Use your mouse or press [AtJ[F], @) to select File ® Open.

E:" The File ® Open icon and menu item will only be active when

Contour It! has been started as a stand-alone program. Under
normal circumstances, all file handling is controlled by “Sight”
Survey.

The Filename Dialog Box is used to select the data file to be loaded.
A typical filename dialog box is shown on top of the next page for
reference. Key areas of the dialog box are identified. (The sample
screen was captured in Windows 95. Your screens may vary
slightly, depending upon your version of Windows.)
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Title Bar > - 11|
Current File Path EilEames “a_ Folders:
File Name box - |cnntuur1_zak | c-hsightsry c :
dnce
. . cadszplit. zak a -y - —I
File selecton menu —— gy g ? = %cﬂghlsw
contowr?.zak 1 collconn
Folders or lesample.zak (] program
Directories box oakwoods. zak = Emigt'y
Drives box ¥ —
List filez of tppe: \ Drives:
List Files of Tvoe box ——————®= [“Sight" Survey Files (~.z 7] | = e =

File ® Triangulate

&

Anytime a File ® Open command is issued, you will be presented
with a filename dialog box. To open a file:

1. If the file you want to open is on a different drive, select the
drive you want from the Drives box.

2. In the Folders (or Directories) box, choose the directory you
want to open. (Double-click the directory, or press the [4] or
[] arrows to select the directory, and then press )

3.  Windows displays the names of all files in that directory that
are of the type selected in the List files of type box. To display
a different type of file, select the type you want from the List
files of type box.

4. From the list of files, select the file you want to open.

5. Click [ok]

Use your mouse or press [At)[F], (T] to select File ® Triangulate.
This item forces the triangulation file to be recreated based upon
the point coordinates. Triangulation is always handled automati-
cally after loading or editing points, so this routine will rarely be
used. One possible use is to quickly reconstruct the contour map
after experimenting with various image rotations.

After the triangulation is complete, the contouring routine is auto-
matically called to produce the contour data.

For more information on triangulation, see What is Triangulation?
on page 4.



File ® Contour

L

[

—_—
R

File ® Export as Bitmap

Title Bar

.
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Use your mouse or press [At)[F], [C] to select File ® Contour.
This item forces the contour map to be recreated based upon the
triangulation file. Contour generation is always handled auto-
matically after loading or editing points, so this routine will rarely
be used. One possible use is to quickly reconstruct the contour
map after experimenting with various image rotations.

For more information on contours, see What is a Contour? on page
1.

Use your mouse or press [At)[F], [E] to select File ® Export as
Bitmap. This selection allows you to create a bitmap image that is
exactly the same as the drawing that is currently on the screen.
Position (rotate, zoom, etc.) the image to your satisfaction, then use
File ® Export as Bitmap to get a “snapshot” of the drawing to
insert into your CAD program, “Sight” Survey, word processor, or
any other Windows application that allows bitmap importation.

|Save As BE

Current File Path

File Name box [contour1.bmp | it |
) . - c: =
File selection menu () sightsry

Folders or
Directories box

File name: \Eolders:

] collconn
N [Z7 program

[ utility [~ Read only

Drives box

Save Files as Tvoe box —T| j | = o j

Save file as type: \Dli!es:

Anytime a File ® Export as Bitmap command is issued, you will be
presented with a filename dialog box. To save a bitmap file:

1. To place the file you want to save on a different drive, select
the drive you want from the Drives box.

2. In the Folders (or Directories) box, choose the directory you
want to save the file to. (Double-click the directory, or press
the [«] or [x] arrows to select the directory, and press )
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3.  Windows displays the names of all files in that directory that
are of the type selected in the Save files as type box. To
display a different type of file, select the type you want from
the Save files as type box.

4. Enter the name of the file you want to save in the File Name
box, or click on an existing name in the list of files shown in
the file selection menu.

If you select a name of an existing file, the existing file will not be
overwritten unless you confirm your intent to overwrite the file.

5. Click[_oK_].

For more information, see What is a Bitmap? on pagel3.

File ® Finish Use your mouse or press [At)[F], (F] to select File ® Finish. This
selection creates the contour macro file, closes the contouring
module and returns control to “Sight” Survey. The contour macro
% file is created based on the settings in the contour setup dialog.
x Also, the drawing object view entities pertain to the macro file as
well, i.e. if borders, breaklines, triangles, or contours are not
displayed on the screen they will not be in the macro file.

Once control has been passed back to the main “Sight” Survey
module, the macro file will recreate the contour map on your
“Sight” Survey drawing.

File ® Cancel Use your mouse or press [Ai)[E], [C] to select File ® Cancel. This
selection cancels the contouring session and return control to
= “Sight” Survey. No contour map is constructed upon your return

I | to “Sight” Survey.

The File ® Cancel icon will only be active when Contour It! has
been started as a stand-alone program. The File ® Cancel menu
item will always be present.
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4.02 The Edit Menu

Shown below are the items in the Edit menu. To select any item
on the menu, click your mouse on the desired selection. You may
also use your keyboard to select a menu item by pressing plus
the underlined letters. For example, select Edit ® Border by
pressing (ARJE), (B], or select Edit ® Drawing Entities ® Triangles
by pressing [(AR)E), O], [T.

Copy
Points
Breaklines
Border
Drawing Entities »| Labels
Contour Setup Triangles
Border Elevation Contours
Breaklines
Border
Edit ® Copy Use your mouse or press [A)E], [C] to select Edit ® Copy. This

selection creates a copy of the display window in it’s current state
and put it in the clipboard. From the clipboard, the image may be
pasted into many other programs, even into the “Sight” Survey text
output window.

Pasting a drawing into another document is normally accomplished
using some sort of Edit ® Paste command. You can often
accomplish this task by pressing (Shift]{Insert] or [Ctrl}(V].

Edit ® Points Use your mouse or press [AR)E), (€] to select Edit  Points. Use
this selection to insert, delete, or edit a value in the data file.

To edit a point, position the mouse on the slider button. Click and
hold the left mouse button. Move the mouse up or down and
release the mouse button when you reach the desired location.
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To Insert a point

To Delete a point

To EDIT a value

[fEdtPonts BN
Point Northing |Easting |Elevation 2 0K |
1 10000100.09 10000101.24  119.65
2 10000102.17 10000205.70  104.94 Cancel |
3 10000103.54 10000305.00 123.76 — |
4 10000107.04 10000402.87 112.62
5 10000106.20 10000506.81 = 119.01 Delete |
6 10000106.91 10000607.50  129.35
7 10000208.55 10000602.43  130.83
8 10000302.70 10000603.05  133.50
9 10000400.01 10000605.77 = 148.61 _

Click your left mouse button once on the point number that will
follow the point you wish to insert (i.e. if you want to insert a point
after point 4, click on point 5). A dotted outline will surround the
point field. Click or press (AR)(1). Type in a new Point
number, Easting, Northing, and Elevation. Use to move
between fields. All columns must contain a value!

Click your left mouse button once on the point number that you
wish to delete. A dotted outline will surround the point field.

Click or press (AtJD]). Just to be sure, a confirmation
window appears.

@ Do you really want to delete this row?

N/ ies%@ Hao

Confirm that you want to delete the point by pressing (Y], clicking
the button, or by pressing [Ete]. If you’ve changed your mind,
press M) or click the button.

Click your left mouse button once on the data you want to edit. A
dotted outline will surround the data field. Once the data is
highlighted, you may replace the value by typing a new one.



Edit ® Breaklines

To Insert a Breakline

To Delete a Breakline
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Use your mouse or press (AtJ[E], (K] to select Edit ® Breaklines.
Use this selection to insert, delete, or edit a value in the breaklines
file.

Edit Breaklines =] B3
From Point |Tu Point IL 0K

112 113 e

113 102 Cancel

103 114 Insert

114 105

106 115 Delete

115 108

Delete All
109 116

To edit a breakline, position the mouse on the slider button. Click
and hold the left mouse button. Move the mouse up or down and
release the mouse button when you reach the desired location.

Click your left mouse button once on the breakline that will follow
the breakline you wish to insert (i.e. if you want to insert a
breakline after point 4, click on point 5). A dotted outline will
surround the point field. Click or press A]. Type in
new From Point, and To Point numbers. Use to move between
fields. All columns must contain a value!

Click your left mouse button once on the breakline that you wish to
delete. A dotted outline will surround the point field. Click

or press AJD). Just to be sure, a confirmation window
appears (as shown on the next page).

Confirm that you want to delete the breakline by pressing (Y],
clicking the button ,or by pressing (Ee]. If you’ve changed your
mind, press (N] or click the button.
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To EDIT a value

Edit ® Border

To Insert a point

@ Do you really want to delete this row?

N/ ies%@ Hao

Click your left mouse button once on the data you want to edit. A
dotted outline will surround the data field. Once the data is
highlighted, you may replace the value by typing a new one. For
more information on breaklines, see What is a Breakline? on
page 6.

Use your mouse or press [(At)E], (B] to select Edit ® Border. Use
this selection to insert, delete, or edit a value in the border file.

Point =] 0K
1 ﬁ
.......... 5 Cancel
10 Insert
11
13 Delete
16
Delete All
Pt. String

To edit the border, position the mouse on the slider button. Click
and hold the left mouse button. Move the mouse up or down and
release the mouse button when you reach the desired location.

Click your left mouse button once on the point number that will
follow the point you wish to insert (i.e. if you want to insert a point
after point 4, click on point 5). A dotted outline will surround the



To Delete a point

To EDIT a value

Edit ® Drawing Entities
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point field. Click or press A]. Type in a new Point,
number. Use to move between fields.

Click your left mouse button once on the point number that you
wish to delete. A dotted outline will surround the point field.
Click or press (AJD). Just to be sure, a confirmation
window appears.

Confirm

@ Do you really want to delete this row?

N/ IESEG Mo

Confirm that you want to delete the point by pressing (Y], clicking
the button ,or by pressing [Ente]. If you’ve changed your mind,
press [N] or click the button.

Click your left mouse button once on the data you want to edit. A
dotted outline will surround the data field. After a brief pause,
click again on the data to highlight it. Once the data is highlighted,
you may replace the value by typing a new one. For more
information on borders, sce What is a Border? on page 3.

The Edit ® Drawing Entities menu allows you to control the
look of your final contour map. Through these items you control
such properties as Color, Line Type, Line Width (1-thin up to 10-
fat), Label Style, and Layer, the layer name on to which the entities
will be placed in “Sight” Survey.

Click on any menu item to select it, or click the right mouse button
on the appropriate toolbar button.
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Edit ® Drawing Entities Use your mouse to select Edit ® Drawing Entities ® Labels or
> Labels press (AR)E), @), [@.

The Label Setup dialog box controls all of your label settings. To
1.3 « select any item, simply click on the field, or button (in the case of
& \% Style), next to the setting you want to modify. Move between

fields with your mouse or by pressing (Tab's) and (Shift}{Tab's). Since
Style uses a Font dialog box, we will discuss the other items first,
while we can make use of the screen illustration below.

Label Setup I
Style: Atial | |~/ DK |
Dptions: | Multiple j| X Cancel |
Starting Contour: |1 E' ? Help |
Contour Multiple: |1 Ii'
Orientation: | Uphill j|
Frequency: |1 1] E'
Precision: | o j|
Layer: | ContLabels j|
Options: This setting controls how many contour lines are to be labeled.
Your choices are:
None No contour lines are labeled.
All All contour lines are labeled.
Multiple Only the “multiple” contour lines are

labeled, as specified by the Contour
Multiple setting.

Non-multiple Only the “non-multiple” contour lines are
labeled, as specified by the Contour
Multiple setting.

To change the setting, click your mouse on the down arrow ( [x])
in the entry box, then click again on the desired setting.



Starting Contour:

Contour Multiple:

Orientation:

Frequency:

Precision:

Layer:

Style:
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This setting is the elevation of the first contour to be labeled. To
change the setting, click your mouse in the entry box and type the
desired elevation.

This setting establishes the number of contour lines between
labeled contour lines. (See Options on the previous page.) To
change the setting, click your mouse in the entry box and type the
desired setting.

This setting controls the direction in which elevation labels are
placed on the contour lines. Your choices are Uphill and North.
Uphill labels are read with the text pointing uphill. North labels are
read with the text pointing to the North, or top of the drawing. To
change the setting, click your mouse on the down arrow ( [¥] ) in
the entry box, then click again on the desired setting.

This setting controls the frequency of label appearance in the
contour lines. This number is actually a percentage of the length of
the contour line. In general, the higher the number, the more
frequently labels will be placed. This number may range from 1-
75, but most common values are between 10 and 20. To change
the setting, click your mouse in the entry box and type the desired
setting.

This setting controls the number of decimal places used when
labeling a contour. You may use 0, 1, 2, or 3 decimal places. To
change the setting, click your mouse on the down arrow ( [¥] ) in
the entry box, then click again on the desired setting.

This setting controls the drawing layer (in “Sight” Survey) upon
which the contour labels are placed. To change the setting, click
your mouse on the down arrow ( [¥] ) in the entry box, then click
again on the desired setting. If you want to use a layer that isn’t an
offered choice, simply type in the layer name.

This setting controls the font style, including font type, size color,
etc. Click your mouse on style button to call up the Font window,
as shown on the next page. Move between fields by using your
mouse or pressing (Tab's) and (Shift}{Tab's). A sample box will keep
you aware of your current selections. When you are done making
changes to your assigned font, click on[_0K_|.
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Font:

Font Style:

Size:

Effects:

Color:

Font
Fant: Font style:
Im IHeguIar
!! Arial Black 1 |Mtalic
Arial Marmow Bold
M Arial Rounded MT Bole Bald Italic
D rows
Arows2
W ArowsdPlentySH LI
T Atlantic Inline LI
—Effecte————————— —Sample
[ Shikeout
AmBhby s
[ Underline FERTYLE
LCalor:
I- Black vI Script:
IWestem ;I

Select the desired font by choosing a name from the Font selection
list. Click and hold the slider button while moving up or down
until the desired font is shown in the list area, then click on the font
name. All of the fonts available to you under Windows are
available in Contour It!

Select the desired font style by selecting one from the Font Style
selection list. Click and hold the slider button while moving up or
down until the desired font style is shown in the list area, then click
on the style name. Not every font has the same available style
choices.

Select the desired font point size by choosing one from the Size
selection list. Click and hold the slider button while moving up or
down until the desired size is shown in the list area, then click on
it.

You may choose either Strikeout or Underline by checking the box
adjacent to your choice. To check or un-check a box, simply click
your mouse on it.

You may choose a font color by clicking on the down arrow ([¥] )
adjacent to the current color. Click and hold the slider button



Script:

Edit ® Drawing Entities
2 Triangles

8%

J@(—

Color:

Line Type:
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while moving up or down until the desired font color is shown in
the list area, then click on the color name.

Depending upon your version of Windows, this setting may or may
not be available. No matter, you will rarely have any reason to
change it from its current setting.

Use your mouse to select Edit ® Drawing Entities ® Triangles or

press (AR)E), @), (T). This selection is used to alter the look and the
layer placement of the of the triangles on the drawing.

To select any item, simply click on the field, or button next to the
setting you want to modify. Move between fields with your mouse

or by pressing M%) and (ShitJT'=). Click the button when

you are satisfied with the triangle settings.

Triangle Settings

Cobor: YR

-
Line Type: [coNTINUDUS =] m
Line Width:
Layer: ITriangIes j|

You may choose a line color by clicking on the down arrow ([x])
adjacent to the current color. Click and hold the slider button
while moving up or down until the desired font color is shown in
the list area, then click on the color name.

You may choose a line type by clicking on the down arrow ( [x])
adjacent to the current line type name. Click and hold the slider
button while moving up or down until the desired line type is
shown in the list area, then click on the line type name.
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Line Width:

Layer:

These are the line types available in Contour It!:

Continuous

Dashed

Divide?

_Divide

You may choose a line width by clicking on the up or down arrow
([=] or [7]) adjacent to the current line width setting. Use these
arrow buttons until the desired line width (1-thin up to 10-fat) is
shown in the data field.

You may choose the layer name upon which the triangulation lines
will be placed in your “Sight” Survey drawing. Choose a layer
name by clicking on the down arrow ( [¥]) adjacent to the current
layer setting. Click and hold the slider button while moving up or
down until the desired layer name is shown in the list area, then
click on the name. If you want to use a layer that isn’t an offered
choice, simply type in the layer name.



Edit ® Drawing Entities
2> Contours

7

J@(—

Color:

Line Type:

Line Width:

Layer:
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Use your mouse to select Edit ® Drawing Entities ® Contours or
press (AR)E), @), [C). This selection is used to alter the look and
the layer placement of the contour lines on the drawing.

To select any item, simply click on the field, or button next to the
setting you want to modify. Move between fields with your mouse
or by pressing M%) and (ShitJT'=). Click the button when

you are satisfied with the contour settings.

Conoursotioss ________&|
oo [———]

.
Line Type: |CIJNTINUIJUS jl m
Line Width:

Layer: | Contours jl

You may choose a line color by clicking on the down arrow ([x])
adjacent to the current color. Click and hold the slider button
while moving up or down until the desired color is shown in the list
area, then click on the color name.

You may choose a line type by clicking on the down arrow ( [x])
adjacent to the current line type name. Click and hold the slider
button while moving up or down until the desired line type is
shown in the list area, then click on the line type name. The line
types available in Contour It! are shown on page 66.

You may choose a line width by clicking on the up or down arrow
([+] or [¥] ) adjacent to the current line width setting. Use these
arrow buttons until the desired line width (1-thin up to 10-fat) is
shown in the data field.

You may choose the layer name upon which the contour lines will
be placed in your “Sight” Survey drawing. Choose a layer name
by clicking on the down arrow ( [] ) adjacent to the current layer
setting. Click and hold the slider button while moving up or down
until the desired layer name is shown in the list area, then click on
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Edit ® Drawing Entities
2 Breaklines

W

\/@(—

Color:

Line Type:

Line Width:

Layer:

the name. If you want to use a layer that isn’t an offered choice,
simply type in the layer name.

Use your mouse to select Edit ® Drawing Entities ® Breaklines or
press (AR)E), @), (K]. This selection is used to alter the look and
the layer placement of the breaklines on the drawing.

To select any item, simply click on the field, or button next to the
setting you want to modify. Move between fields with your mouse

or by pressing M%) and (ShitJT'=). Click the button when

you are satisfied with the breaklines settings.

Breakline Settings [ x| I

« DK

Cobor TP - |

Line Type: [CONTINUOUS =
Line Width:
Layer: | BreakLines jl

You may choose a line color by clicking on the down arrow ([x])
adjacent to the current color. Click and hold the slider button
while moving up or down until the desired color is shown in the list
area, then click on the color name.

You may choose a line type by clicking on the down arrow ( [x])
adjacent to the current line type name. Click and hold the slider
button while moving up or down until the desired line type is
shown in the list area, then click on the line type name.

The line types available in Contour It! are shown on page 66.

You may choose a line width by clicking on the up or down arrow
([+] or [¥] ) adjacent to the current line width setting. Use these
arrow buttons until the desired line width (1-thin up to 10-fat) is
shown in the data field.

You may choose the layer name upon which the breaklines will be
placed in your “Sight” Survey drawing. Choose a layer name by



Edit ® Drawing Entities
2 Border

Jﬁe

Color:

Line Type:

Line Width:
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clicking on the down arrow ( [¥] ) adjacent to the current layer
setting. Click and hold the slider button while moving up or down
until the desired layer name is shown in the list area, then click on
the name. If you want to use a layer that isn’t an offered choice,
simply type in the layer name.

Use your mouse to select Edit ® Drawing Entities ® Border or

press (AR)E), @), (B]. This selection is used to alter the look and
the layer placement of the border on the drawing.

To select any item, simply click on the field, or button next to the
setting you want to modify. Move between fields with your mouse

or by pressing M%) and (ShitJT=). Click the button when

you are satisfied with the border settings.

Border Settings [ x| I

« DK

Cobor [T - |

Line Type: [CONTINUOUS =
Line Width:
Layer: | Border jl

You may choose a line color by clicking on the down arrow ([x])
adjacent to the current color. Click and hold the slider button
while moving up or down until the desired color is shown in the list
area, then click on the color name.

You may choose a line type by clicking on the down arrow ( [x])
adjacent to the current line type name. Click and hold the slider
button while moving up or down until the desired line type is
shown in the list area, then click on the line type name. The line
types available in Contour It! are shown on page 66.

You may choose a line width by clicking on the up or down arrow
([#] or [7] ) adjacent to the current line width setting. Use these
arrow buttons until the desired line width (1-thin up to 10-fat) is
shown in the data field.
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Layer:

Edit ® Contour Setup

X

%

Contour Interval

Minimum Contour

You may choose the layer name upon which the border will be
placed in your “Sight” Survey drawing. Choose a layer name by
clicking on the down arrow ( [¥] ) adjacent to the current layer
setting. Click and hold the slider button while moving up or down
until the desired layer name is shown in the list area, then click on
the name. If you want to use a layer that isn’t an offered choice,
simply type in the layer name.

Use your mouse to select Edit ® Contour Setup or press (At)E], (S).
This function controls the look of the contours. To change any
variable, click on the setting’s data entry box and change the data.
To activate or deactivate the check box item, simply click on the
check box. Move between fields with your mouse or by pressing
(Tab's) and [Shift](Tab's). Click the button when you are
satisfied with the border settings.

Diatg —— —— H|
—Contour Range
« 0K |
Contour Interval: E
"
Minimum Contour: 10000 g
P Hel
Maximum Contour: 10000 g

——v Smoothing

Tension Factor:

Segmente/Curve:

Il

The Contour Interval setting establishes the elevation interval
between contours. You may choose a new value by clicking on the
up or down arrow ( [] or [¥] ) adjacent to the current setting. Use
these arrow buttons until the desired value is shown in the data
field. A much quicker way to set the new value is to double click
on the current value, and when it is highlighted, type in a new
number.

The Minimum Contour setting establishes the lowest possible
contour to be drawn. You may choose a new value by clicking on
the up or down arrow ( [«] or [¥] ) adjacent to the current setting.
Use these arrow buttons until the desired value is shown in the data



Maximum Contour

Tension Factor

Segments/Curve
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field. A much quicker way to set the new value is to double click
on the current value, and when it is highlighted, type in a new
number.

The Maximum Contour setting establishes the highest possible
contour to be drawn. You may choose a new value by clicking on
the up or down arrow ( [4] or [¥] ) adjacent to the current setting.
Use these arrow buttons until the desired value is shown in the data
field. A much quicker way to set the new value is to double click
on the current value, and when it is highlighted, type in a new
number.

The Tension Factor setting controls contour smoothing. The
tension factor may range from 0 to 10. The higher the setting, the
sharper the corners will be drawn. A setting of “0” produces more
curving in the lines, while a setting of “10” produces no noticeable
line smoothing. Any whole or decimal value may entered,
however lower values from 0 to 5 appear to produce the most
aesthetically pleasing results.

You may choose a new value by clicking on the up or down arrow
([4] or [¥]) adjacent to the current setting. Use these arrow
buttons until the desired value is shown in the data field. A much
quicker way to set the new value is to double click on the current
value, and when it is highlighted, type in a new number.

For more information on tension factors, see What is a Tension
Factor? on page 12.

The Segments/Curve setting determines the number of straight line
segments used during line smoothing. The higher the number, the
smoother the contour line will appear. Any value greater than “3”
is allowed, but values between “3” and “10” are recommended.
Values over “15” may cause CAD transfer files to become
extremely large.

You may choose a new value by clicking on the up or down arrow
([=] or [¥]) adjacent to the current setting. Use these arrow
buttons until the desired value is shown in the data field. A much
quicker way to set the new value is to double click on the current
value, and when it is highlighted, type in a new number.
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Smoothing

Edit = Border Elevation

@ CAUTION

Too many segments per curve may cause the contour labels to
disappear. When printed, a contour label replaces a line segment
in your drawing. If the line segments are too numerous, and
therefore too short, your contour labels will be eliminated. For
best results, keep the Segments/Curve setting as close to 3 as

possible.

The Smoothing check box toggles the contour line smoothing
function on and off. If set to “of £,” the settings for Tension
Factor and Segments/Curve are ignored when construction a
contour map.

@ CAUTION

Using contour smoothing is not always desired, especially in
proposed contours, or when using breaklines. Smoothing may
introduce errors in your contour map for the sake of aesthetics.
Too much smoothing may even cause your contour lines to
overlap. Your breaklines, typically straight sections, may also
end up as curved sections when smoothing is employed. Higher
numbers of Segments/Curve will also drastically affect your
drawing file size.

Use your mouse to select Edit = Border Elevation or press (AR)[E],
(E). This function controls the placement of the Border Elevation
on your contour map. To set the elevation, simply type a new
value in place of the value current and click [ 0K _|. To eliminate
the display of the border altogether, simply click on the Show/Hide
Border button ( [i] ) on the toolbar.

Border Elevation

—

Enter the elevation at which the
border should be drawn:

i

X Cancel

Help

k'

,_____
ﬁ
fiao
~J
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4.03 The View Menu

Shown below are the items in the View menu. To select any item
on the menu, click your mouse on the desired selection. You may
also use your keyboard to select a menu item by pressing plus
the underlined letters. For example, select View 2 Border by
pressing (At)V], (B]. Any item preceded by a check mark (V) is
active, and only active items will be included in the drawing

v Labels
v Triangles
v Contour
v Breaklines
v Border
View X Labels Use your mouse to select View = Labels or press (AtJV], (0). This
selection toggles the display of all labels on and o £ £.
1.3 Right click your mouse on the Show/Hide Labels button to edit
i settings for label appearance. See Edit ® Drawing Entities 2

Labels on page 62 for information on editing the appearance.

View ® Triangles Use your mouse to select View = Triangles or press (At)V], (7).
This selection toggles the display of the triangles on and o f £.

% Right click your mouse on the Show/Hide Triangles button to edit
settings for triangle appearance. See Edit 2> Drawing Entities 2>
Triangles on page 65 for information on editing the appearance.

View ® Contours Use your mouse to select View = Contours or press (At)], [C].
This selection toggles the display of the contours on and of £.

Right click your mouse on the Show/Hide Contours button to edit
settings for contour appearance. See Edit 2> Drawing Entities 2>
Contours on page 67 for information on editing the appearance.

7
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View ® Breaklines Use your mouse to select View = Breaklines or press (At)(V], (K].
This selection toggles the display of the breaklines on and of £.

lI|Il IIIII Right click your mouse on the Show/Hide Breaklines button to edit
settings for breakline appearance. See Edit 2 Drawing Entities 2
Breaklines on page 68 for information on editing the appearance.

View ® Border Use your mouse to select View 2> Borders or press (AtJV], [B].
This selection toggles the display of the borders on and of £.

:III:

. Right click your mouse on the Show/Hide Borders button to edit
5000 settings for border appearance. See Edit R Drawing Entities 2>
Border on page 69 for information on editing the appearance.

4.04 The Help Menu

Shown below are the items in the Help menu. To select any item
on the menu, click your mouse on the desired selection. You may
also use your keyboard to select a menu item by pressing plus
the underlined letters. For example, select Help ® Contents by
pressing (At)H], [C].

Contents
Topic Search
About
Help ® Contents Use your mouse to select Help = Contents or press [At){H], [C].

You may also simply press the key. This selection brings up a
help window showing the contents of the help file.
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Click on ary item to zelect it Click on [ S earch ] to look for a specific
topic, ward or phrase. To print any page, click on [ Print |, Clicking [
Back ] takes vou to the previous topic, while the [ > Jand[ €< 1
buttons are next and previous page buttons.

File: b enu

Edit Meru

Yiew Drawing Entities
Eutton Bar

Status Bar

Zoom B ar

Yertical Scroll Bar
Horizontal S croll Bar
Dizplay Window

Eorder Elevation

{% Simplicity Systems H=] 3
Fil= Edit Bookmark Option: Help

Qontentsl §earch| Back | Frint | [€s | xx |

Contour It

CONTENTS

-

|

Across the top of the help window lies a pull-down menu bar,
similar in form and function to the pull-down menus in Contour It!
The pull-down menus are an integral part of the Windows Help

File System.

To select any item on a pull-down menu, click your mouse on the
desired selection. You may also use your keyboard to select a

menu item by pressing plus the underlined letters. For

example, select File ® Open by pressing (At)[F], [©). Some items

may be preceded by a check mark (v) if the item is active.

For the most part, the pull-down menu items are inconsequential to
the operation of the Contour It! help system. For that reason we
will limit the amount of discussion for any particular item to a short

synopsis of the function of that item.

In the Contents window itself, you will notice some words are
written in green, underlined text. These are linked topics. When
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File ® Open

File ® Print Topic

File ® Exit

Edit ® Copy

Edit ® Annotate

you double click your mouse on an underlined word, you will jump
to another section which will give you additional information.

If you see a small image of a paper clip, it indicates that you have
annotated the current topic. To read the annotation associated with
a paper clip, click on the paper clip. For additional information on
annotation, see Edit ® Annotate on page 76.

This selection is used to open a different help file. Contour It!
does not need this function.

This selection is used to print the current topic as shown in the
main window.

This selection is used to exit the help file system.

This selection is used to copy currently highlighted text to the
clipboard. From the clipboard, you can paste the text into another
document. To highlight, place the mouse cursor at the beginning
of the text. Click and hold the left mouse button while moving the
cursor to the end of the desired text. Release the mouse button.

This selection allows you to add notes to the help file. To use
annotation, position the cursor anywhere on the topic screen you
want to annotate. Press (A)E], (A to select annotation.



Bookmark ® Define

Options ® Keep
Help on Top

Options ® Display
History Window
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i Annotate

Current annotation;

"'ou can add pour own notes here. ;I Save
Cancel

Delete

Copy

Pazte

fle el

[

Type your annotation into the window, or click to insert
the contents of the clipboard. When you are done, click [ Save |.
A small image of a paper clip will appear at your annotation spot.
To read the annotation associated with a paper clip, click on the
paper clip. Annotation may only be used once on any particular
topic screen, but you can add to existing annotation at any time.

This selection allows you to add a bookmark to the help file.
Contour It! does not need this function. If you wish to use
bookmarks, please refer to your Windows manual for instructions.

This selection allows you to control the placement of the help file.
Your choices are: Default (on top when in use); On Top (always on
top of the program screens); and Not On Top. This should normally
be set to Default, but On Top is useful when you are using help to
guide you through a procedure.

This relatively worthless Windows feature shows you a listing of
the help files you have recently accessed. Exciting, isn’t it?
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Options 2 Font

Options ® Use
System Colors

Help ® Version

Help Screen Buttons

LContents

Search

This selection allows you to control the size of the help file text.
Your choices are: Small; Medium; and Large. Be bold and daring,
then choose the size you are most comfortable with.

This selection allows you to the preset help system colors to match
your system colors. Any color changes only take effect after the
current help session has ended and a new one has been started.

This selection displays the current help system version and the
name of the help file.

Below the menus you’ll find a button bar containing [ Eentents |,
[[Seach ][ Bask | [ B ][ <« |(page back), and (page

ahead). The functions of each button will be discussed below.

Help Topics: Contour I Help HE
ez | Find |

1 Tupe the first few letters of the word vou're looking for.

2 LClick the index entry you want, and then click Display.

Bith apz -
brmp

Baorder

Barder Elewvation

Break Lines

Button Bar

Cancelling

Clipboard Suppaort

Cantour

Cantours . ;I
Dizplay I Eiirt: | Cancel |

The button brings you back to the contents page from
where ever you are in the help file.

The button allows you to search the help file for specific
phrases, words, etc. When you click this button you call up the
search screen.
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To find a specific topic, narrow your search by typing in the first
few letters of the topic name into the text entry box. In the topic
window, you should soon find a list a topics that begin with the
letters you just typed. View the topic by double-clicking on it, or
click once on the topic and then click [_Dissly .

If you are having difficulty locating a topic, you might want to try
searching for a specific word. Click on the Find tab at the top of
the search screen.

Help Topics: Contour I Help ﬂﬁ
Index  Find I

1 Type the word(z] pou want ta find
I j Clear

2 Select some matching words ko narmow your search Options...

a g Eitrd Sl =rs...

A

B

apout Find How
above

accessed ;
activate - | Bebuild...

3 Click a topic, then click. Display

Edit Border Elevation

Edit Breaklines

E dit Contour Setup

Edit Copy

Edit Drawing Entities LI

|31 Topics Found | I All words, Begin, Auto, Pause |

Display I Brirat. . | Cancel |

To find a specific word, narrow your search by typing in the first
few letters of the topic name into the text entry box, or select a
word in the word selection window. In the topic window, you
should soon find a list a topics that contain the word you just
search for. View the topic by double-clicking on it, or click once

on the topic and then click [_Dissly .

The button brings you back to the previously accessed
section from where ever you are in the help file.
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Windows printer control.

The button brings you back one page from where ever you
are in the help file.

The button prints the current topic using your standard

The button moves you ahead one page from where ever
you are in the help file.



Section 5
Buttons

The Button Bar

Shown below are Contour It’s Button Bars. The first button bar is
used when Contour It! is run from within “Sight” Survey. The
second button bar is used when Contour It! is run as a stand-alone

program.
| (& (2] (VBN
=[] (B[] & [2]e] [N ]G

The Button Bar mirrors most of the functionality of the menus.
Several buttons perform different functions for both the left and
right mouse button.

File Open Left click: Opens a new contouring file. See File ® Open on
IEI page 53 for more information.

Right click: No function.

= File Cancel Left click: Cancel contouring and exit the contouring module.
I | See File ® Cancel on page 56 for more information.

Right click: No function.
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&

.l|[r

File Triangulate

File Contour

File Finish

Edit Contour
Setup

Edit Border
Elevation

Left click: Triangulates and refreshes the contour map. See File
2 Triangulate on page 54 for more information.

Right click: No function.

Left click: Computes and draws the contour map. See File ®
Contour on page 55 for more information.

Right click: Activates the Contour Setup dialog window. See Edit
2> Contour Setup on page 70 for more information.

Left click: Finishes the contouring session and exits Contour It!.
See File ® Finish on page 56 for more information.

Right click: No function.

Left click:  Activates the Contour Setup dialog window. See Edit
2 Contour Setup on page 70 for more information.

Right click: No function.

Left click:  Activates the Border Elevation dialog window. See
Edit ® Border Elevation on page 72 for more information.

Right click: No function.
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7

Show/Hide
Points

Show/Hide
Triangles

Show/Hide
Contours

Show/Hide
Breaklines

Show/Hide
Border
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Left click: Toggles the point number display on and off.

Right click: Allows you to set the properties for point and label
display. See Edit ® Drawing Entities = Labels on page 62 for
more information.

Left click: Toggles the triangle display on and off.

Right click: Allows you to set the properties for triangle display.
See Edit ® Drawing Entities ® Triangles on page 65 for more
information.

Left click: Toggles the contour display on and off.

Right click: Allows you to set the properties for contour display.
See Edit ® Drawing Entities ® Contours on page 67 for more
information.

Left click: Toggles the breakline display on and off.

Right click: Allows you to set the properties for breakline display.
See Edit ® Drawing Entities = Breaklines on page 68 for more
information.

Left click: Toggles the contour display on and off.

Right click: Allows you to set the properties for border display.
See Edit ® Drawing Entities = Border on page 69 for more
information.
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5.02

Zoom Scroll Bar
and Slider

Slider Buttons - Zoom & Scroll

Shown below are Contour It's horizontal and vertical Slider
Buttons. These buttons are used to zoom and scroll your contour
map or digital terrain model.

@ Contour It |_ (O] x|
Fil= Edit Yiew Help

t Foom slider “Yerical Scroll slider :T
Zoom Scroll bar “ertical Scroll bar

Harizontal Scroll bar
Horizontal Scroll slider
) =
&l [ i

o

The Zoom Scroll bar and Zoom slider (located on the left side of the
contouring window) control the scale of the drawing on the screen.
It therefore changes the scale of an image that is copied or saved as
a bitmap, but it has no effect on the image that is in “Sight” Survey.
The image returned to “Sight” Survey will always match “Sight”
Survey’s drawing scale.

There are several ways to zoom the image:

1. Click your left mouse button on the up or down arrow keys
([+] or [x] )above or below the slider bar;

2. Position the mouse on the slider button. Click and hold the
left mouse button. Move the mouse up or down and release
the mouse button when you reach the desired scale;



Vertical Scroll Bar
and Slider

Horizontal Scroll Bar
and Slider
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Position your mouse on the slider button, then click the left
mouse button. Position the image using the keyboard’s up and
down arrow keys ((1] or (3] );

Click your mouse above or below the slider button, between
the slider button and the arrow key at the end of the scroll bar.

After re-scaling an image you may need to reposition the image
using the Horizontal Scroll Bar and the Vertical Scroll Bar.

The Vertical Scroll Bar (located on the right side of the contouring
window) controls the vertical position of the image in the
contouring window.

There are several ways to move the image:

1.

Click your left mouse button on the up or down arrow keys
([=] or [x]) above or below the slider bar;

Position the mouse on the slider button. Click and hold the
left mouse button. Move the mouse up or down and release
the mouse button when you reach the desired scale;

Position your mouse on the slider button, then click the left
mouse button. Position the image using the keyboard’s up and
down arrow keys (1] or 3] );

Click your mouse above or below the slider button, between
the slider button and the arrow key at the end of the scroll bar.

The Horizontal Scroll Bar (located near the bottom of the
contouring window) controls the horizontal position of the image
in the contouring window.

There are several ways to move the image:

1.

Click your left mouse button on the left or right arrow keys
([® or [»]) at either end of the slider bar;
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2. Position the mouse on the slider button. Click and hold the
left mouse button. Move the mouse left or right and release
the mouse button when you reach the desired scale;

3. Position your mouse on the slider button, then click the left
mouse button. Position the image using the keyboard’s left
and right arrow keys ( (€ or 5] );

4. Click your mouse above or below the slider button, between
the slider button and the arrow key at the end of the scroll bar.

5.03 Mouse Button - Rotate the Drawing

Shown below is the contouring display window. This window
contains a preview of the image that will be sent back to “Sight”
Survey, or saved. The image in the window below represents an
un-rotated display.

lﬁ Contour It M= 3
File Edit “iew Help

]

o

k| [

Drag the drawing to change view position. Shift to rotate.
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To rotate the drawing, click and hold the left mouse button while
pointing the mouse at the image. Move the mouse and the image
will rotate. Hold the key down while moving your mouse to
rotate the drawing about an axis normal to the monitor. If you get
the drawing into a unusable position and want to reset it, just click
the Contour ( [&]) or Triangulation ( [&] ) button . A rotated image
is shown below.

lﬁ Contour It _ (O] x|
Fil= Edt “iew Help

B

=] =
Kl _ [

Drag the drawing to change view position. Shift to rotate.
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Py Section 6

i Stand-Alone

Startup as a Stand-Alone

In “Sight” Survey Professional, Contour It! is located on the Add-
Ins pull-down menu. Since you are running Contour It! as a stand-
alone program, you must open the program using a different
method.

Windows 3.1

Mouse Method: Double-click on the Simplicity Systems program
group. When the group window opens, double-click on the
Contour It! icon ([&]).

Keyboard Method: Press (At)E],R] to open the File ® Run dialog
window. Type C:\SightSrv\Program\Contour into
the filename box and press Fe]. (If necessary, change the drive
letter and directory name to match your installation.)

Windows 95
Button Method: Click on the Windows 95 but-

ton. Point to Programs. After a moment, the program list appears.
Point to Simplicity Systems. After a moment, the Simplicity Sys-
tems program group list appears. Click on the Contour It! icon

(ED.

Keyboard Method: Press (At)S], R to open the Start ® Run
dialog window. Type C:\SightSrv\Program\Contour
into the filename box and press or click[__OK_]. (Change the
drive letter and directory name to match your installation if
necessary.)

If you are running the example problem now, return to the sub-
section Fill’er Up on page 25.

Section
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6.02 File Structures

Points The structure of a point file is:

total number of points in file
point Easting Northing elevation
point Easting Northing elevation

where each piece of information is separated by a space. The first
line of the file indicates the number of points in the file. Note that
the Easting (or X coordinate) comes before the Northing (or Y
coordinate). A typical point file would look like this:

21

1 20000.000 10000.000 119.650
2 20104.460 10002.080 104.940
3 20203.760 10003.450 123.760

16 20506.260 10006.820 129.350
21 20406.570 10026.130 119.550
where 21 (on the first line) is the number of points in the file.

Border The structure of a border file is:

total number of points in file
point
point

where each piece of information is separated by a space. The first

line of the file indicates the number of points in the file. A typical
point file would look like this:

w NN R B

where 4 (on the first line) is the number of points in the file.
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Breaklines

Another Plug

The structure of a breakline file is:
total number of breaklines in file
point point
point point

Stand-Alone
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where each piece of information is separated by a space. The first
line of the file indicates the number of breaklines in the file. A

typical breakline file would look like this:

5

10
16
12
34
25

18
15
34
25
41

where 5 (on the first line) is total number of breaklines in the file.

Creating Files

If the COGO program you are using will not let you export points

into an ASCII file, you can create your own point file by using a

word processing program or text editor. Just be certain to save the

file in a Text Only (no formatting) type of file.

You can also use your word processor/text editor to construct

border and breakline files. Again, be certain to save the file in a
Text Only (no formatting) type of file.

Of course, you could always call us and order a copy of “Sight”

Survey Professional. It is a really good COGO & CAD program.
But don’t take our word, read the review from “Professional

Surveyor” on page Error! Bookmark not defined..

Our toll-free telephone number is (800) 777-7978. If you are
outside the US and Canada, please call (218) 773-8917. You can
also order over our web site at www.simsystems.com

Section



92 Stand-Alone

This page intentionally left blank.



AT Section 7
g Trouble?

7.01 Startup & Loading Problems

Contour It! does not Contour It! is located on the Add-Ins pull-down menu inside of
appear on the “Sight” “Sight” Survey. The actual menu item is Make Contour Lines (MC).
Survey Add-Ins menu The Add-Ins menu is located between the Utilities and Windows

pull-down menus. If you can’t find the Add-Ins menu, you should
first be sure that you are running the “Sight” Survey Professional
version, and that your “Sight” Survey serial number is 970812 or
greater. You can find both these items shown on the bottom of the
System Information screen within “Sight” Survey. Enter the
routine code ST to access this screen.

If you do not have the Professional version, or if your serial
number is less than 970812, you may wish to call our sales office
at 1-800-777-7978 to purchase a “Sight” Survey upgrade. Pricing
will vary depending upon the version of “Sight” Survey that you
currently own. If you do not wish to purchase the upgrade, you can
still use Contour It! as a stand-alone program however, you will
not be able to use it seamlessly integrated within your “Sight”
Survey program.

If you do have the Professional version, and your serial number is
970812 or greater, then Make Contour Lines (MC) should appear on
the Add-Ins menu, however, it may appear grayed-out or dimmed.
If you are unable to access Contour It! because the selection is
dimmed, then Contour It! was installed to the wrong directory.
Contour It! must be located in the same directory as your
“Sight” Survey Professional program. The default name that the
installation program uses for this directory is:

Drive:\SightSrv\Program

where Drive is replaced by the drive letter where the program is
installed.
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Running Contour It!
Across a Network

lllegal Function Call

Program Appears to
Hang Upon Startup

If Contour It! is being run across a local area network (LAN)), it is
important that all users have read/write access to the program
directory. If users do not have access to this directory, an error
will occur when they try to load the program. The most common
error to occur under this situation is an Access Denied error, but
the exact error will vary depending upon your system setup. The
user will not be able to run the program until he has access rights to
the directory where Contour It! is installed. The default name that
the installation program uses for this directory is:

Drive:\SightSrv\Program

where Drive is replaced by the drive letter where the program is
installed.

If Contour It! issues an Illegal Function Call error when it first
attempts to load into memory, it is most likely because an invalid
configuration setting exists in the CONTOUR.INI initialization file.
To correct the situation, simply use the Windows 3.1 File
Manager or the Windows 95 Explorer to delete the initialization
file from the Contour It! program directory and restart the
program. The default name that the installation program uses for
the directory containing the initialization file is:

Drive:\SightSrv\Program

where Drive is replaced by the drive letter where the program is
installed.

If Contour It! appears to hang or “lock up” when it first loads into
memory, it is most likely because an invalid configuration setting
exists in the CONTOUR.INI initialization file. To correct the
situation, simply use the Windows 3.1 File Manager or the
Windows 95 Explorer to delete the initialization file from the
Contour It! program directory and restart the program. The default
name that the installation program uses for the directory containing
the initialization file is:

Drive:\SightSrv\Program

where Drive is replaced by the drive letter where the program is
installed.
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7.02 File Problems

Contours were not completed successfully.
Small point ligt

Your point list, i.e. your data file, contains fewer than three points,
and therefore is an invalid file. A Contour It! file must contain at
least three points before triangulation can be completed. Add
points to your data file and try again.

Warning

Two pointz with the same coordinates were found in the file. Select Points
from the Edit menu and remove one data point. The Points are 101 and 200.

Two, or possibly more, duplicate points have been found lurking
around in your data file. The offending point numbers are shown
so you don’t have to hunt them down. Delete the offending points
using the Edit 2 Points routine as described on page 57.

Contours were not completed successfully.
[nput error in border filel

You have a data error in your border file. Remember, Contour It!
must have a valid border before it can triangulate and contour data.
See What is a Border on page 3. Use the Edit ® Border routine
described on page 60 to fix your border.
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Error E2

Both files must be triangulated before volume calculations can be
performed.

This message indicates that the secondary file has never been
processed by Contour It!. It cannot be used until you have
triangulated the file. You must:

1. In “Sight” Survey, open the secondary file and Make Contours
on it.

2. Return to “Sight” Survey and open the primary file and Make
Contours on this file.

3. In Contour It!, select File ® Calculate Volume and continue.

Running Contour It! as a Stand-Alone Program

1. Use File ® Open to open the secondary file.
2. Use File ® Open to open the primary file.
3. Select File ® Calculate Volume.

4. Select the secondary file and click[__0K_].

Warning

& Cannot triangulate the coordinates.

This is a general indicator of bad data in the border or points file.
Use the Edit routines to check your data. It may be helpful to
return to “Sight” Survey and check your data visually.
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\‘I.?) It appears you have made changes to the list of points sent to Contour It Do you want to replace
the original points with the: modified ones?

You have used the Edit ® Points routine to change a point’s
coordinates or elevation, or perhaps you added or deleted a point.
Contour It! needs to know if you want to return your changed
points to “Sight” Survey and make them a part of the permanent
data file.

Breakline & Border Problems

Warning

103 to pt. 112. Select Breaklines from the Edit menu and adjust the

.n_'j The breakline from pt. 102 to pt. 113 intersects with the breakline from pt.
breaklines accordingly.

Your breakline file contains crossing breakline(s), a no-no. Use
the Edit ® Breaklines routine to remove the offending breaklines.
See What are Breaklines on page 6.

‘Warning

The border segment from pt. 124 to pt. 109 intersects with the border
segment from pt. 108 to pt. 111. Select Border from the Edit menu and
adjust the border accordingly.

Your border file contains crossing border line(s), another no-no.
Use the Edit ® Border routine to remove the offending breaklines.
See What is a Border on page 3.
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The pt. 117 lies on the breakline from Pt. 102 to 112. Select Breaklines
from the Edit menu and adjust the breaklines accordingly.

Your breakline file contains a breakline(s) that crosses a data point.
The only way Contour It! allows a data point to touch a breakline
is if the data point anchors one end of the breakline. Use the Edit
2> Breaklines routine to modify the offending breakline. See What
are Breaklines on page 6.

You can also run into border trouble that does not generate an
error message. See Section 7.06 - Trouble at the Border for
more information.

7.04 Volume Problems

Contour It! is only as good as the data you provide. It’s the old
adage, “Garbage in...Garbage out” played out to its fullest extent.

If you are having trouble generating valid volume calculations, the
problems often stem from one of four sources:

Incomplete Field Data The problem of incomplete field notes can be rectified by having a
survey crew revisit the site.

Bad Borders Bad borders may be corrected by editing your border points using
the Edit ® Border routine. You should also review the section
Border Rules on page 4.

Bad Breaklines In order to properly triangulate your data, you may need to add
breaklines. Review the section What are Breaklines on page 6. Use
the Edit ® Breaklines routine to modify the offending breakline.
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Contour files that do not overlap, or overlap only partially may be
your problem. Contour It! cannot compute volumes on non-
overlapping files.

For example, if the relationship between your two surface maps
looked like this:

]
N

No overlapping area so
= 4 no volume computed.

no volume could be computed because no portions of the files
overlapped.

If the relationship between your two surface maps looked like this:

P

"— Volume computed only
in overlapping area.

only the volume in the overlapping area would be computed.

If your problem is caused by different coordinate bases, use
“Sight” Survey’s (or your COGO’s) Coordinate Transformation
routine to translate one file to the same base as the other. Don’t
forget to re-contour the translated file before computing a volume.
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7.05

Label Problems

If you have set up Contour It! to include contour labels in your
drawing and they do not appear, you may have a problem with the
label being too large or too frequent. However, this problem is
usually caused by your Segments/Curve setting.

Too many segments per curve may cause the contour labels to
disappear. When printed, a contour label replaces a line segment
in your drawing. If the line segments are too numerous, and
therefore too short, your contour labels will be eliminated. For
best results, keep the Segments/Curve setting as close to 3 as
possible.

Adjust the Segments/Curve setting by using Edit ® Contour Setup
as discussed on page 70.

Adjust the Font Size and Frequency settings by using Edit 2
Drawing Entities 2 Labels as discussed on page 62.

Trouble at the Border

You've gathered your field data, reduced your notes to COGO
points, and imported your data into Contour It. But wait...
something's wrong! Your triangles are running across your border
and are out of control! Arrrgh!!! This stupid program doesn't
work!

Well, before you get too stressed out, let's begin by saying the
program works just fine. It's doing everything it can to help you
get an accurate contour map. But there is one thing it cannot do,
and that is what is causing the problem. It doesn't have the benefit
of sight. It hasn't seen the lay-of-the-land. And, it cannot read
your mind.

You need to help it.
Consider the data set from the file Contour1.zak. Suppose we load

the data into "Sight" Survey and plot the points, excluding points
10-14, 28, 29, 36, and 37. We would have the following plot:
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Now we type MC to Make Contour Lines and we select the points
we want to take into Contour It. Again, we'll bring in all of the
points, except points 10-14, 28, 29, 36, and 37.

Contour It automatically chooses a border, and triangulates and
contours the data. If we click on the Show/Hide Contours button
(E|), we would see the Contour It screen at the top of the next

page.

Notice how we have triangle lines from point 15 to points 39, 27,
30, 35, and 9. You don't have data for this area, but Contour It is
attempting to contour the area anyway. Why? Because the
automatic bordering procedure calculated a border line stretching
from point 9 to point 15. We can see this by clicking on the
Show/Hide Triangles ( [#] ) button to turn off the triangles and show
us only the border. This is shown in the Contour It screen at the
bottom of the next page.
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3 Contour It - CONTOUR1 [_ O] =]
File Edit Yiew Help

=
-]

=]
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Contour It screen showing triangulation of data.

38 Contour It - CONTOUR1 [_ O] %]
File Edit Miew Help
QEI &l [2[2] i
B
1=
I
i1 = 1
A _ i

Contour It screen showing automatically generated border.

The triangulation is correct because it falls within the selected
border. The solution lies in changing the border. We select Edit
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2 Border and insert the necessary points to create the correct

border, enumerated in the Edit Border window below.

E:“Q@Edit Border

3b
30
27
39
21
15
16

Cancel

Insert

Delete

Pt. String

When we click [_0K_], Contour It re-triangulates and contours the
data. If we click on the Show/Hide Contours button ([&] ), we
would see the correct triangulation.

Eile

=

Edit

S8 Contour It - CONTOUR1

“iew  Help

B
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Good Borders Are Critical!

One other situation can cause improper triangulation and thus bad
contour generation. This occurs when we have a data point lying
outside the border.

Suppose we select Edit ®Border and delete point 30 from the
border. Maybe we thought (incorrectly) that point 30 would lie
inside a line from point 9 to point 27, and therefore we could omit
it from our border list. Our triangulation would look like this,

S8 Contour It - CONTOUR1
File Edit “iew Help

=]
I
ﬂﬂ%ﬁ

with triangulation lines stretching from point 30 to points 39 and
15. This is because point 30 actually lies outside a border line
from point 9 to point 27 and Contour It thinks it can triangulate
point 30 to points 9 and 27 without crossing a border line.

@ VERY IMPORTANT

It is critical that you do not bring any data points into Contour
It! unless they lie within the border of what you want to
triangulate and contour. To include extraneous data points will
always lead to incorrect triangulation. Either use Edit ®Border
to include the points, or use Edit Points to delete the data
points in question.
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Section 8

Getting Help

Help!

Simplicity Systems, Inc., provides support free of charge (but not
toll-free) for 90 days from date of purchase, provided the user has
returned a signed software registration form.

Experience demonstrates that well over 80% of the support calls
we receive could be avoided if the caller would first look in the
manual. Many long hours have gone into the preparation of this
manual in an effort to provide all of the information necessary to
the operation of this program. So please check the manual before
you call.

Telephone support is available ONLY at the following numbers:

Voice: 1-218-773-7966
Fax: 1-218-773-3849
E-mail: support(@simsystems.com

Support is also available on our web site at www.simsystems.com

Support hours are 8:00am to 5:00pm (Central time), Monday
through Friday, exclusive of holidays. If all incoming support lines
are busy, your call will be answered by our answering service and
you will be given an option to leave your name and number, or you
may wish to simply try your call again later. Call backs on
messages left on the answering service will be returned collect, in
the order they are received with the exception that customers on an
Unlimited Support Plan will always be given top priority.

If at all possible, please be at your computer when you call for
support. This way a support technician will be able to step you
through the procedure in question, which will save you the frustra-
tion of trying to remember our instructions at a later time. It will
also be helpful for the technician to know the exact procedural
steps you were following when you encountered the problem.

Section
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Raw Data files and Text Output printouts are especially helpful
for this.

If your question or problem does not require an immediate answer,
please write down your problem and mail or fax it to the Simplicity
technical support department including printouts, data disks, etc.
Include your program serial number, your phone and fax numbers,
and the hours/days you may be available. A support technician
will solve your problem and provide you with the solution by mail,
fax, or telephone.

You are encouraged to become as familiar with the operation of
your computer as possible. When helping you, we will often ask
you to perform certain functions such as: Copying a disk; Format-
ting a disk; Checking the contents of a disk, directory or folder;
and Copying, Renaming, and Moving files. It is not within the
scope of our technical support plans to assist you with, or tutor you
on the use of Windows. Therefore, it is to your advantage to be
familiar with these commands before you call.

If you are having a problem such as constant input/output (I/0)
errors, etc., chances are good that the problem is hardware or me-
dia related. Please contact your hardware dealer first.

8.02 Support Plans

The subject of charging a fee for technical support is a controver-
sial subject across the software industry. However, when you
compare the initial product cost, it appears that many of the com-
panies that do not charge for technical support have actually built a
prepaid support charge into the price of their software package. If
you are like most people, you don’t want to pay for something that
you may never use.

At Simplicity, we pride ourselves on dependable, practical, and
perhaps best of all, affordable software solutions. We have not
“built-in” a prepaid support charge into the price of our software.
You get a great program with well-written documentation and up to
90 days of free support. We do not charge you “up front” for
software support that you may never need.
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After the initial period of free support, users who feel they will
need additional help are encouraged to subscribe to one of our
support plans. A technical support order form was enclosed with
the shipment of this program. Please refer to this form for prices
and updated information on the following support plans.

Customers who do not subscribe to a support plan will be auto-
matically transferred to the Basic Service when their 90 days of
free support has expired.

The One Year Unlimited Support Plan provides unlimited, pri-
ority telephone, fax, and E-mail support on all Simplicity software
for one year for $199 for a single user, $279 for multiple users.

The Basic Service Support Plan provides non-priority telephone
support for all Simplicity software on a $45.00 per incident basis.
This plan is designed for the user who rarely needs support and can
use Visa, MasterCard, or American Express for the billing.

Updates & Upgrades

It is Simplicity’s policy to regularly maintain and update our soft-
ware programs. Occasionally, Contour It/ may undergo slight
changes such as minor enhancements, bug fixes, etc. which we
refer to as software revisions or updates.

These changes may or may not result in a change of the internal
version number of this program. For example, the first revision or
update of Contour It! after its initial release will most likely be
referred to as Contour It! 1.01. The next revision/update would
most likely be Contour It! 1.02, etc. These updates are available
for a nominal fee.

Much less frequently, this program may undergo major changes
such as the addition of new routines, etc., which may or may not
require the addition of a manual addendum. These changes will
always result in the change of the version number. For example,

Section
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the first upgrade of Contour It! will most likely be referred to as
Contour It! 2.0. These upgrades are available for a fee com-
mensurate with the changes that have been made.

Whether you choose to update and/or upgrade this program is
strictly optional. Depending on the changes that have been made
during each release, you may choose to purchase every update, or
you may choose to “skip” any update and purchase the next one
when the changes may be more substantial. Either way, the choice
is yours.
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